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1 Initiation
1.1 System start
Press the silver operation button under the pre-amplifiers connections at the back of the
device.
ATTENTION! The RJ45 connectors are NOT the network connections!

Wait until the system has completely initiated itself.
Note: There’s the possibility of the hard drives being checked on start-up, especially
when the system has not been shut down properly or when there was a black out. This
procedure can take a long time.

1.2 Starting the Analyzer4D
As soon as the Optimizer4D has been booted up the graphic user interface appears. The
software is based on a Linux system.
Usually, the Analyzer4D application is started automatically after booting.
Note: Depending on the configuration it is possible that the Analyzer4D application does
not start automatically.

If necessary, start the program by clicking on the Analyzer4D logo with your mouse (or your
finger on the touch screen).

1.2.1 Access data and login
When starting the program you might have to put in your personal access data to log in
(QASS usually delivers the devices without pre-set passwords):

Illustration 1.2.1: Login Dialog

To log in you require your user name and password. If you have not received your access data
yet, please contact the administrator.
You can enter your access data via a connected keyboard or the virtual keyboard, to access
the latter press thje keyboard symbol next to the input box. After entering your data, click the
Login-button.
5

1.2 Starting the Analyzer4D
If no error message appears, you are logged into the system and can start working with
the Optimizer.
Note: If you want to learn more about the user management and the different user
levels, please read the chapter „ Details – user management“.

1.3 System shut down
ATTENTION! NEVER turn off the Optimizer4D via the main switch!

Shut down the Optimizer4D by accessing the menu item

File → Shut down system

.
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2 Basics
2.1.1 Projects, processes, buffers
2.1.1.1 Buffer
A buffer displays an accumulation of measuring data. These may either be the original raw
measuring data, as it originally has been recorded, or compressed data which has already been
edited. A buffer is also a kind of display filter for measuring data. It is possible to create a
new buffer with old measuring data, regardless of whether there is an active measuring or not.
Different buffers display the data in different ways, e. g.:
• FFT
• Signal
• RAW
• Data reduced average value
• … etc.
2.1.1.2 Process
In the Optimizer4D system, a process stands for one single measuring, while one measuring
can consist of different buffers.

Image 2.1: A project can contain several processes and processes contain several buffers.

During a measuring session, normally, raw data buffers are created, which are comprised of
the data streams from the measuring channels 1-4. At the same time, during the measuring,
compressed buffers are calculated from the raw data. These are, usually, the so-called
maximum buffers, which simplify the subsequent navigation and the detection of significant
events.
Note: A Process consists of multiple buffers.

2.1.1.3 Project
A project is an accumulation of processes, i.e. several readings or a series of measuring within
one automatic production process:
Note: A project consists of multiple (many) processes.

Furthermore, a project contains information about single processes. The project may also
administrate reference processes, which are a basis for a quality- or quantity-comparisons for
automatic production processes.
2.1.1.4 Process landscape
7

2 Basics
The three dimensional illustration of the acoustic signals of a production process (e. g.
milling, straightening, assembling, wire drawing, etc.) is called the process landscape.
Acoustic signals measured by the Optimizer4D are: Structure-borne sound up to a frequency
of 12.5 MHz. These time signals are disassembled into their frequency components by using
efficient Fourier transformation and are, then, projected into a three dimensional coordinate
system. The resulting landscape of „impulse mountains“ gives information about the kind and
the quality of the process.
2.1.2 Program surface

Image 2.2: Program surface: View Tab - Monitor

The program surface is the user interface of the Analyzer4D application.
The main area of operations takes up most oft he viewable screen.
This area is divided into different tabs, which can be accessed via the top edge of the screen:
Monitor

View of the process landscape and the 3D-graphic
Log

Message window with status, error, and process messages of the application
Statistic

Statistic analysis of the crack detection in thje application of straightening processes.
Module

Monitoring oft he measuring board and hardware.
SQL tools

General SQL query editor for the database of the Optimizer4D
The standard view is the Monitor. This tab shows the measuring data and the status messages
during the automatic use of the Optimizer4D.

At the top edge of the screen a menu bar, as known from other PC-programs, can be found.
This menu grants access to a multitude of advanced options, which are not accessible via the
main view area.
Please check the chapter Details Menu, which explains all functions oft he menu.
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2.1.3 Tab – Monitor
The tab Monitor gives access to the work area, which starts measurings, displays processes
and analyses process data. This is the most important tab.
2.1.3.1 Graphic area
The graphic area takes up the biggest part of the screen( shown as mostly black in the image).
This is the working area oft he screen, where the process pictures are visualized in 3D, or
diagrams of signal measuring data is shown.
We call this 3D display „Process landscape“.

Underneath you can find the „Navigation“, a kind of time line, that shows a smaller
representation of the complete buffer in the current graphic area.
The Navigation is used for navigating the data and to quickly select a certain time frame of
the current process.
The graphic area, usually, contains a „viewing area“ but can also contain multiple
viewing areas and therefore multiple process landscape views.
Also see:

Menu → view → Set number of views

Image 2.3: Navigation (Navigation time line) shows the current process as a whole

2.1.3.2 Monitor – Main Tool bar
Vertically on the right side of the screen you can find the
enables additional access to the Process , selection ,
Buffer , Recording , Automation and Video option.

main tool bar box

. This

For further explanations see „Details – Tool box“.

When clicking the tool box buttons the corresponding tool group will open at the
bottom the the screen, in the so-called secondary tool bar.
2.1.3.3 Monitor – secondary tool bar

Image 2.5: Example – Tool boxes in the side tool bar

In the secondary tool bar all open tool boxes are displayed. Furthermore, the
„time basis“ can be found here, which can change the scaling of the time line,
and thus the time frame in relation tot he whole process.
On the lower right the „transport tool box“ can be found. An important function,
that is used to start and end a measuring.
The layout is inspired by cassette players.

Image 2.4: Main
tool bar

2.1.4 Tab - Scope
Note: The Scope function may be unavailable to you, according to your program
configuration and your software version. In that case the scope tab is not displayed.

Choose the tab „Scope“ to let the program switch to the corresponding area. There you find
an oscilloscope-like instrument, with which you can measure signals and signal strength.
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Image 2.6: Tab - Scope

2.1.4.1 Scope – main tool bar
The scope interface, also, provides a main tool bar, on the right side, which differs
from the functionality of the other main tool bars.
Further information can be found in the chapter „Measuring - Scope“
2.1.4.2 Scope – secondary tool bar
The Scope secondary tool bar can be found at the bottom of the screen and gives
access to a „time base“ and „transport tool box“.
With this function the scope can be used.

Image 2.7: Scope - Side tool bar

2.1.5 Tab – Log
The Log area saves the procedures of the Analyzer4D application, showing which functions
have been used and if or what errors have occurred. It’s worth it to check the log, if the
Analyzer4D is not reacting as expected.
The Optimizer4D writes every important message into multiple files on the system. The log
window only shows the most recent messages.
These log-files can be read by a service technician and are used for finding problems in the
software.
Note: In case of an error during measuring, information can be found in the „log“ window!
10
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Image 2.8: Tab - Log - Log Window

Delete:

Deletes all content oft he message window.
Stop:

Stops the „automatic scrolling“ of the window content, when new messages appear. That way the
window does not automatically jump to the newest message, while older messages are being read.
Analyzer4D debug level:

The higher the debug level, the more is shown by the Log-Window. If complex processes are to be
reviewed, the debug level can be set to 1 or 2. A higher number will show messages that are used by
developers and service technicians.
Attention! In an automated process the debug level should be 0.
Search for:

A text can be entered in this box, that can be searched for with the buttons

Previous

and

Next

.

Export log to USB:

Click this button to easily copy all the log-files and the files /var/log/messages on a USB stick. In
the following dialogue-window choose the USB stick and click on use selected USB device . The log
files will now be copied to the main folder oft he USB stick.
Load complete log:

The content of all, up until now, created log-files will be shown in the message window. (It can take a
while to load, depending on the size of the file)
Note: The log-files are rotated and deleted in regular intervals.

2.1.6 Tab – Module
The tab Module shows whether the measuring card has be initialized properly. The latter can
be seen when the display of the Module Status is green.
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Image 2.9: Main display - Tab - Module

Attention! If the display of the „module status“ is not green, there is a communicational
error with the hardware. Then, the Optimizer4D System has to be rebooted. In pure
analysis-systems the measuring card will, of course, not be found.
Note: Should the display of the „PCI hot-plug“ be red, do not interpret it as an error!

All other functions of this tab are for developers or service technicians.
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3 Data handling
3.1 Monitor
3.1.1 info view area
The monitor is separated into one, two or three view areas

Illustration 3.1: View Area (Data)

And the navigation time line for the data that is being viewed:

A view area shows the graphical representation of the process, or a buffer of the process, the
so called process landscape.
Furthermore, there is a view area information box in the upper left corner of the view area,
which shows information about what data, buffer and process is being shown at the moment.

With the help of this box the data view areas can be turned on or off. The view area can show
multiple signal levels, of the process landscape, at the same time, the „main signal“, as well
as 2 different reference levels.
For every level there is a „level box“ available.
The view of the levels can be changed by clicking the appropriate level box. A green
background of any box means „visible“.
Note: The visibility of the main signal level cannot be turned off.

A double click on the level box (upper) expands, or collapses, the layer boxes (underneath).
The boxes may cover the view of the process landscape.
Note: Also see „Reference level“ further down.

3.1.2 Buffer Box
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3.1 Monitor
The „Buffer Box“ informs about all currently available buffers,
which normally belong tot the currently loaded process, but can also
consist of other processes or foreign files.

Il

Note: The buffer box can be moved freely, by clicking the
upper anchor box.
A click on the anchor box will expand or collapse the available buffers.

The buffer boxes show information about the data of the buffers,
their process affiliation, the compression or the Data type.
Also see „Data types“.

Buffer:
A buffer shows an accumulation of measuring data. This measuring data
can either be original raw measuring data, the way they have been
saved initially, or compressed, already processed, data. With this the
different data types of a buffer are made.

Process:
A process stands for a single measuring in the Optimizer4D system,
whereas a measuring consists of multiple buffers.
lustration 2: Buffer Box
Normally, during a measuring, raw data buffers are created, which
consist of data streams of the measuring channels 1 to 4. Simultaneously to the measuring,
compressed buffers are created from the raw data. Those, usually, are maximum buffers, which ease
the following navigation and the identification of significant events.

Illustration 3.2: Maximum Buffer

Illustration 3.3:Moving average

Note: A process can consist of multiple buffers.

Project:
A project is an accumulation of processes, i. e. different series of measuring or a series of measuring
during an automated production process.

A click inside one of the buffer boxes sets the corresponding buffer as the “main signal“ in
the view area, and the view of the process landscape is updated simultaneously.
Note: If multiple view areas exist, the buffer box has to be pulled into the target view area, to
activate the corresponding buffer.
The individual buffers can, also, be pulled into the so called target box, which will
temporarily open, to activate the wanted view. This is crucial, if multiple view areas are
active. (view Illustration 3.4: Drag and Drop of the Buffer Box)
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3.1 Monitor

Illustration 3.4: Drag and Drop of the Buffer Box

Note: If the buffer box shows an “*“ behind the data type, it is modified and has to be
saved, or the project has to be saved.

3.1.2.1 Buffer Box context menu
When pressing the right mouse button, a context menu, with further options referring to the
clicked buffer, will open.
Note: If the input method is the touch display, the
finger has to be pressed on the buffer box until the
menu opens.

•
•
•
•
•
•
•
•
•

Show info
Import offline Data block
Freeze Buffer (Unfreeze)
Save Buffer
Save Buffer as...
Export Buffer into CSV file
Change comment
Remove Buffer
Remove Buffer from disc

Illustration 3.5: Buffer Box context menu

Show Info

Shows information about the buffer: When it has been recorded, what data it is compiled of, etc. This
function can fail, if the buffer has been modified.
Import offline data block

Tries to import all data of the chosen buffer into the RAM memory.
Freeze Buffer

Shows the buffer as frozen or unfrozen. A frozen buffer will not be removed from the memory when
changing the process. This is important, if the buffers of several processes are to be compared.
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Save Buffer

Saves the Buffer. A file name will be automatically assigned with help of the currently running
project. If that isn’t possible, a dialogue box opens to select a file.
Save Buffer as...

Opens a dialogue box to choose where the buffer should be saved.

Export Buffer into CSV file
Saves Buffer as an ASCII CSV file. A dialogue box will ask for the file path and name, you wish to
save it as.
Change comment

Enables the editing of the comment box of the buffer. (This is not the process comment, but a
specific text, which can be fixed to every single buffer. The comment will be shown in the header of
the buffer file, not in the data base.)
Remove buffer

Deletes the buffer from the memory – however, it does not delete the buffer from the hard drive or
the project. The buffer will, simply, not be shown in the buffer box anymore.
Remove Buffer from disk

Deletes the buffer, including all corresponding files, from the hard drive.
Attention! Doing this will delete the buffer irrevocably!

3.1.3 Navigation of the graphic window (in the view areas)
The process landscape in the view area of the graphic area can be moved as follows:
A left button click of the mouse on the graphic display enables movement of the graphic.
A right button click of the mouse on the view area enables rotating the process landscape
about two axes, so as to view it from all sides.
With the scroll wheel of the mouse the process landscape can be zoomed in on and out of.
When using the touch screen the desired function (Move, rotate, zoom) has to be chosen
beforehand, due to not having mouse buttons..
This can be done via the main tool bar on the upper right side of
the screen with the Touch mode-Buttons:
„Move“ activates the movement mode
„Rotate“ activates the rotate mode
„Zoom“ enables the zoom in and zoom out options
3.1.4 Sensitive areas
Additional operating elements in the view areas are the so called sensitive areas, e. g. the axis
of the coordinate system.
When getting close to an axis, with the mouse, it will flash yellow. This is true for all three
axes: the time axis (x-axis), the frequency axis (z-axis) and the amplitude axis (y-axis)
When clicking the (now yellow) axis, the special function, of the sensitive area, is used.
These are:
3.1.4.1 Sensitive time axis
When hovering the mouse over the x-axis (=time axis), it can be chosen with the left mouse
button, to move the process landscape on the time axis.
Note: This function is also available when using the touch screen
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Illustration 3.6: Sensitive time axis

3.1.4.2 Sensitive amplitude axis
The sensitive y-axis (=amplitude axis) gives access to a horizontal help layer: A click on the
axis, which has to be yellow now, expands the help layer, by moving into the axis’s direction
after the click.

Illustration 3.7: Sensitive frequency axis

This help layer can be an additional guide line. Furthermore, the time scale always begins at 0
on this help layer – regardless of the part in the process you are at.
Thereby you get a better assessment of the signal lengths of the shown process.
The height of the elevated help layer is shown as a yellow decimal, at the lower left corner of the
corresponding view area. This value is the height of the amplitude of a signal reaching the height of
the help layer. This value has no unit, although it roughly represents the acoustic energy in that
discrete frequency line.

In many cases the help layer is also used as reference layer or used to help with the
parametrization.
Note: This function is also available when using the touch screen.
3.1.4.3 Sensitive frequency axis
The z-Axis (=frequency axis) offers a vertical help layer. This helps with reading the
amplitude values more easily. The axis also offers an additional time scale at the upper border
of the screen.
Note: This function is also available when using the touch screen.
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Illustration 3.8: Sensitive frquency axis with amplitude help layer

3.1.4.4 Sensitive Marks
The process-marks, which can be set as a kind of book mark in the process landscape, are
sensitive elements, as well, which will become yellow when touched by the mouse and offer
special functions.
Check chapter „Menu → Edit and „Marks“.

3.1.5 Navigation time bar
Die navigation bar, the Navigation, is used to jump through the time line of a process, or
adjust the size of the chosen time frame, which you want to be shown in the view area.

Illustration 3.9: Navigation timeline and section from View Area

The navigation bar is underneath the graphic area of the monitor. The blue area shows the
relation between the chosen time frame and the whole process.
The navigation itself shows the current whole process, or the buffer, which has been chosen
for the active view area.
Attention! If the navigation does not show any process data, the chosen buffer is
unsuitable for the navigation or the signal amplitude is very low.

When the “automatic navigation” in the „Preferences – System“ option is active, the
navigation will try to find a displayable buffer automatically, should the chosen one not work.
Furthermore, the display of the navigation can be stretched vertically through the main tool
bar’s “navigation scale” option.
Also see „Buffer“, „Buffer Box“.
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The blue area is called Slider. The slider is used to move the current process section on the
time line.

A left click on any area of the time line that is not covered by the Slider will immediately
show you the corresponding area. The view area section will be moved to the exact point in
time.
Similarly, the size of the section (and thereby the adjustment of the “time basis”) can be
changed by left-clicking on an area in the navigation bar, that is not blue and then choosing
an area with Drag 'n' Drop.
The same function is available with a right-mouse click, this way you do not have to take the
slider into consideration. Drag 'n' Drop with the right mouse button always works.
Attention! The touch screen only emulates a left mouse click!

By pressing the middle mouse button the area can be enlarged:
Clicking the area on the right side of the Slider enlarges it to the right (= into a later time
frame), clicking the area on the left side of the slider, enlarges it to the left (= into an earlier
time frame).
Reminder: The navigation always shows a compressed buffer of the process.
If no compressed buffer is available, the navigation bar will not show a summary of the process. The
background will be displayed in black. The blue area of the Slider will still be displayed, however the
summary in the navigation bar will not.

Inside the blue area are green markers. Those markers, actually, show the selected area, and
not the blue Slider.
Note: The slider can not become smaller than its minimum size, so that it can always be
selected.

The smaller the displayed area, the closer the green markers will be together, so that they will
not be able to be selected any more via mouse or touch screen. Therefore, the blue area, which
functions as an active button, has a minimum size. Should the size fall below the minimum,
only the green markers will show the displayed area.

Below minimum size
3.1.6 Reference layer
The view areas show the data of a single buffer and thus of a single process, while in
standard configuration.
That is the process landscape or the „Main Signal“, the way it is shown during a running
measuring.
Additionally, two so called Reference layers can be activated, which show the content of
other buffers or processes in a transparent overlay over the “Main layer”.
That way different buffers or processes can be compared or calculated against each other.
Working with reference layers:
When a buffer-button in the „Buffer Box“ is clicked and moved via the mouse an additional
functions box appears, the target box, with the sub items „Main“, „Ref. layer 1“, „Ref. layer
2“, „freeze“ and „delete“.
Also see „Buffer Box“
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3.1 Monitor

Illustration 3.10: Drag and Drop Buffer to Reference layer

Now the data of a buffer can be shown as a reference layer by dragging the “buffer box” to
one of the “Ref. Layer target box“. Beneath the view info box a new “layer info box“ appears,
which is used to turn the reference layer on and off, as well as to show information of the
data.
Example: In this example the buffer, with a maximum compression, has been put over the main
layer, with sliding average.
Vie images Illustration 3.11: Main Signal and Illustration 3.12: Main Signal + Reference Signal

Illustration 3.11: Main Signal

By clicking the „layer box“ the reference layer is activated and shows the maximum buffer
above the sliding average in a transparent form.
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Illustration 3.12: Main Signal + Reference Signal

3.1.6.1 layer box – context menu
A right-click on the “ref. Layer box” opens the context menu.

Illustration 3.13: Signal layer box –
context menu

Clear buffer

unbinds the allocation of a buffer to the reference layer.
Freeze

freezes the allocation, so that it is not lost when changing the process in the view area. This is a
simple possibility of showing multiple processes in the view area at the same time.
Show info

opens a dialogue with detailed information about the
buffer, which is used as a reference buffer in the
reference layer.

Scale

opens the adjustment wheel to scale the amplitude of
the reference signal.

Illustration 3.14: Reference layer
„show info"

Offset
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enables the sliding of the reference signal's image in height.

Illustration 3.15: Reference layer „Offset"

Transparency

regulates the transparency of the upper layer's image.

Illustration 3.16: Reference layer transparency 1

Illustration 3.17: Reference layer transparency 2

3.1.6.2
3.1.6.3 reference layer – examples
Three buffers are shown in a view area by assigning buffers to both reference layers.
Here the buffer is assigned with the data type “standard deviation” to reference layer 2:
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Illustration 3.18: Main Signal + two reference layers

This can be activated by clicking it (The „layer info box“ becomes green).

3.1.6.4 view info box – context menu
The „view info box“ is an information box at the upper left corner of the
screen. Coupled to the view info box are the ref. layer box.
This box tells you, what process, or what data / buffer is shown at the
moment (e. g. maximum buffer of process 3).

In the „view info box“ is a context menu that can be
activated via a right click.
It contains the choices „Normal view“, „Double view“ and
„Triple view“. With these three options the number of view
areas can be changed. Usually, the „Normal view“ is used.

Illustration 3.19: Area
Box

Illsutration 3.20: Area Box – context menu

3.1.6.5 View area – Double view
When choosing Double view, in the context menu of the “view info box”, or in the
Set Number of views , the view area is split into an upper and lower half.

View →

23

3.1 Monitor

Illustration 3.21: Dual view

With the mouse the border between the two view areas can be selected and moved, so that the
display can be viewed in different sizes. (This is a „sensitive element“, as well)

Attention! The functionality of the buffer box changes a little, when the double view is
active. It is no longer possible to set the buffer for the “main layer”, or the “main process
landscape”, with a simple click on the buffer button.

As with the „Normal view“ mode, the buffer boxes are still available. The buffers can not, however,
be chosen by a simple click any more. The box has to be dragged into the corresponding area, or
the buffer box has to be dragged into the additional target box (target box), that provides multiple
targets. In this case, the „Main layer“, „Reference layer 1“, „Reference layer 2“, „freeze“ or
„recycle bin“.
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Illustration 3.22: Dual view – target box

The clicked view area is always active. You can distinguish it via the more intense colouring
of the graphic. The Navigation bar always refers to the active area.
There is one exception. If a View Area is “linked” to the navigation, the active area and all
linked areas are influenced by changes in the navigation bar.
3.1.6.6 Triple view
„Triple view“ offers three view areas. To view an area in the other areas, you can drag and
drop the view from one area to another, and a copy of the view will be shown.
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Illustration 3.23: Triple view

3.1.6.7 switch X-Scale
„switch X-Scale“ sets the beginning of a time scale to zero. Thus, the time scale can not be
used to check the absolute number, any more, but the relative number in relation to the
beginning of the coordinate system (Therefore the starting time of the shown area).
The time scale will be shown in red to indicate this fact. This condition can be cancelled
by re-clicking the option.

3.1.6.8 Switch freeze state
„switch freeze state“ freezes the whole area, so that it's contents can not be changed any
more. If you now try to drag a buffer into the area, an error message will appear („target
frozen“).
The „view info box“ will show the note „frozen“. This condition can be cancelled by reclicking the option.

3.1.6.9 cut link
This function cuts the view area link, which can exist between multiple view areas.
3.1.6.10 Linking view areas
Pressing „L“ will link views with each other and the navigation bar.
This means, that their contents will be synchronized.
In the „view area info box“ the note „linked to X“ will be shown.
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In this case the linked view areas are moved with the navigation. This way, both the sliding
average and the maximum, for example, can be displayed.

3.2 Use of the time base

Illustration 3.24: Time base

The „time base“ defines the size, i. e. the length of time of the excerpt of the current process,
that is being looked at in the view area. This is comparable to the time base used by
oscilloscopes.
The current value is displayed numerically in the Direct input field. (in the image: 992ms)
These are the Base unit buttons, which are used as multipliers for the set total
time. µs, ms, s are available here.
The time value can be increased and decreased by clicking and holding the control dial,
with your mouse, and pulling up or down. The use of this feature with the touch display is the
same.
Changes to the time base have immediate effects on the display of the currently active view
and the navigation time bar.
Illustration 3.25: Navigation bar – the size of the blue area matches the Time base

Note: Changes to the time base only affect the current view!

The time base area can be directly changed in the white field: A click into the field opens a
virtual keyboard, which allows the direct input of the desired time
factor.
If a mouse is used, this function is also available via the “up” and “down”
arrow keys next to the field, which add or subtract 1 [time unit].
Note: When changing the time base, the middle of the currently
viewed area is scaled.

Zoom around focus axis
If a certain area of the display has to be zoomed in on, e. g. a displayed
peak, the following trick can be used:
A click with the middle mouse button on the point in time, which is of
interest, in the process landscape, makes a green vertical axis appear,
the focus axis. When afterwards changing the time base, this axis is
used as the zooms centre, so that it stays in your field of vision.

Illustration 3.26: Zoom around
focus axis
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4 Analyse

4 Analyse
Not available in the manual version
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5 Details

5 Details
5.1 Menu functions
5.1.1 Menu → File

Image 5.1: File-Menu

5.1.1.1 File → Clear all
With Clear all the currently loaded project will be closed. All currently saved data in the main
memory will be deleted. All open buffers will be removed. If there is any modified data in the
main memory a security query will occur.
Note: The project will only be deleted from the current view of the Analyser4D
application, no data of the system or data base will be deleted.

5.1.1.2 File → Create new project
Create new project creates a new, empty project.
Note: If a saved default project exists, the configuration (Multiplexer, crack detection, pattern recognition, etc.)
will be transferred. This way the Optimizer can be easily adapted to a special machine with different sets of
work piece parameters.

More information under „Create new project“.
5.1.1.3 File → Load project
Load project opens a dialogue box, which allows to load a previously saved project into the
main memory. If that project contains a list of triggers, or a global list of triggers exists, the
trigger system will be automatically activated. The automation, i. e. the process evaluation by
the monitoring modules, will be activated, as well.
5.1.1.4 File → Save Project
Save Projekt saves the current project, and simultaneously all modified buffers, into the
directories, pre-set by the project. Furthermore, all project parameters, as well as markers, etc.
will be saved.
Note: After a finished measuring the project is saved automatically.

5.1.1.5 File → Recent Projects
Shows the projects, last used, and allows to select one of those.
5.1.1.6 File → Project (Sub-menu)
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5.1.1.7 File → Project → Project Information
Project Information opens a summary dialogue for the current project and it's parametrization.

Image 5.2: Project Information – Project summary

In the input field comment notes can be entered.
Furthermore, it is possible to change the path names of the process data and assign an I/O ID
to the project.
Note: Using the trigger system a project can be loaded automatically via it's I/O ID.
(See chapter Details: Trigger)

The option Deactivate automatic buffer deletion locks the project and it's measuring files from
being automatically deleted, should the hard drive's minimum memory be reached. (Also see:
Konfiguration → Adjustment → Minimum hard drive memory )
5.1.1.8 File → Project → set I/O ID
Opens a dialogue, that allows to set or change a project's ID. The I/O ID can be used by the
trigger system. This way it is possible to change the projects in the Analyser4D by using I/O
input signals from the SPC of the machine. This enables the switching between different sets
of work piece parameters.
Should the entered I/O ID already be used by another project, a warning message will
pop up, and you will you have the possibility of taking the old project's ID to assign it to
the current one.
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5.1.1.9 File → Project → Lock / unlock Project
This option enables a project, that is based in the file system, to be safeguarded against
saving. This allows an archived project to be protected from being overwritten.
Clicking this menu option again will revoke it.
Attention! An active, or productive, project must never be locked!

5.1.1.10 File → Project → Delete current Project
Deletes the currently loaded project from the memory, the hard drive and the data base.
Further details about this in chapter: Project manager.
5.1.1.11

File → Project → Delete oldest process files

This function is for service technicians or developers.

Should the hard drive of the Optimizer4D system be full, no new measuring can be started.
During a productive, automated operation, with the correct configurations, this should not
happen.
If the harddrive's remaining memory limit has been increased, this function can be used to
manually delete process data, so the system can measure again.
5.1.1.12

File → Project → load from database

This Function is obsolete.

5.1.1.13

File → Project → Save in database

This function is for service technicians or developers.

Saves the current project explicitly in the database. This, usually, is not necessary, since File
→ Save project does the same. Should projects be imported from file systems or external USB
drives it might make sense to save the project parameters in the database with Save in
database .
5.1.1.14

File → Project → Load from remote system

This function is for service technicians or developers.

Enables opening projects that are saved on remote Optimizer4D systems.
This function searches the network for archive servers or other Optimizer4D systems. A
selection dialogue will show all found remote systems or allows you to input an IP address.
After confirming the address, a project selection dialogue will open, which shows the projects
of the remote system.
These can now be used as if they were on the owned Optimizer4D.
All changes will be saved on the remote system!
Attention! The remote system must not use the same project!

5.1.1.15

File → Project → Load from file system

This function is for service technicians or developers.

Loads a project, that is not saved in the database, from the hard drive. ´This way projects, that
have been copied from another system or a USB harddrive, can be imported into the
Analyzer4D software.
In the file selection dialogue, that will open, a project file has to be chosen. These end with
“.opt”.
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Should no “.opt”-file be available (which is the case when files have been copied with the
system file manager), the last file from the RAW folder can be loaded too. A project will be
generated, automatically.
Note: A project, that has been generated this way, does not include the original
measuring configurations.

5.1.1.16

File → Project → Save into file system

This function is for service technicians or developers.

Generates a project “.opt”-file in the project file folder.
Note: No measuring data is copied this way.

5.1.1.17 File → Project → Polycyclic Mode on/off
Activates or deactivates the polycyclic mode.
The polycyclic mode is used for projects with very long measuring or with multiple
measuring cycles per component.
5.1.1.18

File → Project → Delete reference file

Function is obsolete

5.1.1.19

File → Project → Copy to archive server

This function is for service technicians or developers.

Should the Optimizer4D be integrated into the network, and the network have a Optimizer4D
archive server, measuring data can be saved there.
Also see chapter: Use archive server
5.1.1.20 File → Export → Buffer as CSV
Exports the currently selected buffer as CSV.
See Details export data and Details Buffer CSV Export
5.1.1.21

File → Import CiS-configuration

This function is for service technicians or developers.

The function allows the import of a QASS CiS.01 measuring system's flash card.
This way the CiS.01 can easily be replaced by an Optimizer4D system. All sets of work piece
parameters will be transferred from the flash card and will be available on the Optimizer.
Attention! This function affects the whole system. Basic configurations, characteristic
lines, and the complete system behaviour will be re-parametrized after the import!
Existing projects might not be set properly any more.

5.1.1.22 File → Project manager
The “Project manager“ manages the different projects and measuring files that have been
recorded with the Optimizer system so far.
5.1.1.23 File → Log Out
Logs out the current user and logs in the standard user with standard rights.
5.1.1.24 File → Log In
Opens the user sign-in dialogue and allows the logging in of a different user name.
5.1.1.25 File → Close Analzyer4D
Closes the Analyser4D application.
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You get back to the Optimizer4D system interface. The READY signal will be deactivated, to
tell the SPS that the Optimizer is no longer operable. The Analyser4D application can be restarted by clicking the corresponding icon.
5.1.1.26

File → Shut down System
Shut down System closes the application and shuts down the Optimizer4D system and turns it
off.

5.1.2 Menu → Process

Image 5.3: Process-Menu

ATTENTION! The menu items in the “Process” menu are only useful, when a project is loaded or a
new project has been created.
5.1.2.1 Process → Load process with number
Load process with number loads any process of the current project by it's manually entered
process number. The process number is entered with the virtual keyboard. Loading a process
means, that all data buffers, linked to that process number, will be loaded into the memory or
made available as an offline buffer.
Tip: A right click on the process selection button will enable you to search and load a
process by it's date and time.

5.1.2.2 Process → Load next Process
Load next process loads the process following the currently viewed one, as long as this is not the
last process.
5.1.2.3 Process → Load previous process
Load previous process loads the process previous to the currently viewed one, as long as this is
not the first process.
5.1.2.4 Process → Reset reference process duration
This function is obsolete

This function deletes the time, that is set as the reference process duration. The reference
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process duration enables an automatic end of the measuring, depending on a maximum
process length. The reference process duration will be automatically re-set, when the next
measuring starts and will then be set to the length of that measuring.
Further details under „Trigger“.
5.1.2.5 Process → Delete current process
Delete current process deletes the current process of the project, as well as all it's data, from the
hard drives, thus from the whole system.
Attention! This function influences all process numbers that are higher than the currently
loaded process, and should only be used by experts. References of the statistic to the
processes will be deleted or will link to the wrong process data.

5.1.2.6 Process → Delete process area
With this function a series of processes can be deleted, after inputting a From/Until time
frame.
Attention! The latest, available process number should always be used as the upper limit.

5.1.2.7 Process → Delete last process
Same as with Delete last process , a process will be completely deleted, this time that last,
available process. This function is useful, if, during a measuring, you notice that the
measuring is useless or undesired. It will immediately delete the data from the project.
Compared with Delete current process and Delete process area this function is safe considering
the data consistency.
5.1.2.8 Process → Add comment
Add comment allows you to enter a comment for the current process, which can be viewed in
the view area of the process topology of the process, at the upper left corner of the screen.
5.1.2.9 Process → Create new empty process
This function is for developers

Creates an empty process and puts it at the back of the current project. The project contains
no buffers. Buffer data can be entered manually and later be saved as a process.
5.1.2.10

Process → Change current process into new process

This function is for developers

Changes loaded buffers into a process, which is put at the end of the current project. The
buffers will be marked as modified, so that they will be saved as new files when saving the
project.
This expert function is used, for example, to create a functioning process with foreign buffers.
5.1.2.11 Process → Delete current Raw data files
Deletes all raw measuring data of the current process. Compressed buffers is preserved.
5.1.2.12 Process → Delete current compressed data
Deletes the compressed buffers of the currently viewed process. Raw measuring data is
preserved.
5.1.2.13 Process → Repair → Set origin of time scale
With this function the time scale of the process topology can be adjusted. Move the view to
the desired place, click Set origin of time scale and put in a time in ms. The chosen point in
time is now at that part of the process, that you have shifted the view to.
Please note that only the view scale is changed. Functions that use the time markers use the
actual measuring time and not the time set on the scale.
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5.1.2.14

Process → Repair → Adjust buffer header and time alignment

This function is for developers

This function allows the cutting of buffers, that means setting a new start and a new end.
The buffers will react in every function, as if they had always started with the new start and
end times.
Note: This function can be reversed. The original buffer can be restored at any time.

Furthermore the frequency and oversampling of buffers can be changed too, to correct
incorrect measurements.
5.1.2.15

Process → Repair → Determine current process info

This function is for service technicians and developers.

When importing process data, or when copying buffers, processes and projects, the process
and buffer information will not be imported into the data base. These can be found with
Determine current process info .
The application will try to find process data on the hard drive and put these into the data base.
5.1.2.16

Process → Repair → Determine process infos of complete project

This function is for service technicians and developers.

See function Repair → Determine current process info
This is used for all processes of the current project.
5.1.2.17 Process → Record audio comment
This function can be used to record an audio signal, which is added to the process as an audio
buffer, by using the sound input of the Optimizer4D system.
The Play function allows listening to the recorded audio comment.
During the recording a microphone will flash in the view area.
Using the ESC key will end the recording.
Note: To use this function, the sound card of the Linux system has to be set up
accordingly. The configuration can not be done in the Analyser application.

5.1.3 Menu → Display
The “Display“ menu contains functions and options, which are used to configure the general
display, or the 3D view of the monitor.

Image 5.4: Display-Menu

5.1.3.1 Display → Zoom in on selected
The currently picked data area will be zoomed in on up to the size of the whole coordinate
system of the view area. This, especially, applies to the frequency axis of the FFT buffer view.
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5.1.3.2 Display → Activate/Deactivate zoom
Should a zoom be active on a data selection in the process topology, which you can see by the
red number on the frequency axis, it can be activated and deactivated with the
Activate/Deactivate Zoom option.

Image 5.5: Current Data selection

→ Image 5.6: Zoom in on selected

5.1.3.3 Display → Highlight selection
Data, that is not part of the currently selected area, can be removed from view with the
Highlight Selection option.
Note: The menu function Highlight Selection and Zoom
Selection , which can be opened with the main tool bar.

in Selection

are also situated in the tool bar

5.1.3.4 Display → Reset Selection and Zoom
The current selection and a possible zoom will be reset.
Furthermore, multiple display options will be reset to their default and also possible error
messages in the process view will be deleted.
This function can be accessed by pressing “ESC”, as well.
5.1.3.5 Display → Fullscreen
Opens the application in full screen mode, the window bar will not be shown.
5.1.3.6 Display → Set number of views
With this function, the number of views in the
window can be set. 3 views (process topology
views) can be set at once.

Image 5.7: View areas (Triple view)

Note: This function is the same as the one, that can be accessed via the context menu when
clicking the right mouse button, called “View info box” (Single view, Dual view, Triple
view).
5.1.3.7 Display → Show detailed buffer box
When this function is activated, the buffer boxes, on the right side, will display more
information about the underlying data, e. g. memory usage, used data blocks and buffer
length.
5.1.3.8 Display → Decode Logarithm in FFT Files
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When this function is activated, the application will calculate the logarithm of the buffer data,
which have been parametrized in the multiplexer configuration. Since the view is now
normed to a higher value, the lower amplitudes will cave in, while the higher amplitudes will
rise.
(see chapter Buffer Logarithmic Data)
5.1.3.9 Display → Hide I/O object markers
Fades out the green marker frame, which were created by an external trigger in the I/O input
or by a sample recognition.
5.1.4 Menu → Buffer
The Buffer menu offers functions for the manipulation, the creation, and the import of buffers.

Image 5.8: Buffer-Menu

5.1.4.1 Buffer → Buffer creation
With Buffer creation compressed buffers can be created for one or more processes. The
function opens a dialogue box, which allows the creation of compressed buffers, in the form
of batch processing, for one or all processes of the current project.
See „Buffer-subsequent calculation“
5.1.4.2 Buffer → Create compressed buffer
Here, based on the currently selected buffer, a new, compressed buffer will be calculated,
which compression type can be chosen in the sub menu of Create compressed buffer.
The following compression types are available:
•
•
•
•
•
•
•
•

Down-sample (easy data reduction, which preserves every nth spectrum)
Maximum (the maximum amplitude will be searched within n spectra)
Average (The simple average of n spectra)
Sliding Average (t) (Average of n spectra with smoothing over time)
Sliding Average (t&freq.) (Average of n spectra with smoothing over time and frequency)
Standard Deviation
Second FFT (FFT calculation, with FFT Data, with parametrizable FFT dimension in ms)
Significance (A special compression, which eliminates the background emission and
highlights significant events)
„n“ stands for the factor of compression. The degree of compression, can be set under: „Menu
→ configuration → Preferences“.
The buffer, created this way, will be placed at the end of the current process.

5.1.4.3 Buffer → Import CSV
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Enables the loading of external data, for example data of other measuring devices, into the
Analyser4D application via a CSV file. This data can be converted into a buffer, which will
act like a 3D-landscape
This buffer can be made into an overlay over the process data, with help of the reference layer
function, for visualization.
5.1.4.4 Buffer → Import signal data
Opens a dialogue that allows the import of signal data that has been measured by other
systems.
This function is especially useful to import measuring data from the QASS CiS.01 measuring
system.

Image 5.9: Import signal data dialogue

This dialogue gives the option to set the kind of signal, or the data structure of the file.
Further information in chapter „Import external data“
5.1.4.5 Buffer → Open
Open gives access to a file selection dialogue, that allows you to load any file, that contains
buffer data, for example from another project, into the current process.
Note: At this moment, the function only shows a foreign buffer temporarily. The buffer
can not be permanently assigned to the process, i. e. the buffer will not automatically
load.

5.1.4.6 Buffer → Save
Saves the currently selected buffer, if it has been modified. The directory, where the process
data will be saved into, results from the project and its configured directories.
Note: Modified buffers are only created by functions, that create new buffers, at the
moment. Measuring data will always be saved automatically.

5.1.4.7 Buffer → Save as
Saves the currently selected buffer with any name at any place in the file system.
5.1.4.8 Buffer → Save buffer as JPEG
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Here a profile picture of the currently viewed buffer will be created, with the full length of the
process and a dialogue box will open, that allows you to save the picture as a JPEG picture
file on your hard drive or a USB stick.

Image 5.10: JPEG – profile picture

5.1.5 Menu → Edit

Image 5.11: Edit-Menu

5.1.5.1 Edit → Set mark
With this function a mark can be set at significant places of the process, which help with
orientation or documentation. A short comment can be added too. These marks will be saved
in the project context and will be available when the project is reopened.
There are two ways to set a mark.
1.) Choose Menu → Edit → Set mark and click on the place in the process, which you want to
be documented. A cross-hairs will appear for selection. This can be adjusted as long as the
left mouse button is pressed. When letting go of the button, the marker is set and a virtual
keyboard will open.

Image 5.12: Virtual keyboard

Here you can enter the comment or labelling. When the mark has been set, it can be moved by
pressing it and holding the left mouse button, and then dragging it in the process display. A click on
the labelling field will open the virtual keyboard, so that it can be changed. A right click can delete
the mark, after making sure. A click with the middle mouse button can pull the labelling closer to
the mark.
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Image 5.13: Marks (Marking - Flag)

2.) With a middle mouse button click a temporary mark will be placed at your desired location.
(A vertical, green line, the ”Focus point“ appears at the corresponding location).
Afterwards go to Menu → Edit → Set Mark and a new process mark will appear in the temporary
mark's place, which will have the standard name “Mark“, which can be changed with a left click.
5.1.5.2 Edit → Jump to next Mark
Jump to next mark jumps to the next mark, which is situated behind the current process section,
in a chronological manner. This function can also be used via the right cursor key.
Note: Should no further marks be set, nothing will happen.

5.1.5.3 Edit → Jump to previous Mark
Jumps to the previous mark, which is chronologically before the viewed process section. This
function can also be used via the left cursor key.
Note: Should no further marks be set, nothing will happen.

5.1.5.4 Edit → Selection groups
Using the Selection groups dialogue, you can set a so-called selection group. A selection is a
rectangle in time and frequency, that encases a process topology. A selection group is made
up of multiple selections. You can create up to six of those groups.
Each set is a basis for a statistical analysis; the dialogue can be accessed either by clicking the
Open dialogue for statistical analysis button in the selection groups dialogue, or via the menu
item Analysis → Statistical functions → Dialogue for statistical analysis.
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5.1.6 Menu → Configuration

Image 5.14: Configuration-Menu

The configuration menu offers access to all configurations and parametrization options of the
Analyer4D program, or the Optimizer4D system.
Tip: All menu items above the dividing line (above OpenGL) refer to the currently
loaded project. All functions underneath the line are for system-wide pre-settings.

5.1.6.1 Configuration → Multiplexer
Opens the dialogue „Multiplexer“
Here the measuring channels, measuring sample rate and the corresponding inputs are
configured.
(See Details – Multiplexer)

5.1.6.2 Configuration → Trigger settings
Opens the dialogue „Trigger settings“. Here the so-called trigger list is created and the trigger
system configured.
The trigger system is a smaller kind of internal SPC. By cyclically processing the trigger
list (about every 2ms), the input signals, I/O events, output signals, warning messages
and the process monitoring are connected to each other.
(See Details – Trigger settings)

5.1.6.3 Configuration → Crack detection settings
Opens the dialogue “crack detection”.
In this dialogue the crack detection is parametrized.
In the crack detection module, the different crack objects are created and parametrized, which
monitor the measuring data of the current process.
Calling it crack detection is a bit misleading; because the crack detection module
monitors overstepping energy values in the measuring data streams, within a
predetermined time and frequency area.
We speak of cracks when, within a short time of less than 10ms, the energy value
behaves erratically. The correct name would be energy pulse.
(See Details – Module crack detection)

5.1.6.4 Configuration → Measuring parameters
Opens the dialogue “Measuring parameters”, which configures advanced measuring settings
in the current project.
In the measuring parameters dialogue you determine which compressed buffers (Data
streams), should be generated automatically during the measuring, additionally to the raw
data.
(See Details – Dialogue measuring parameters)
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5.1.6.5 Configuration → calibration of sensors
Opens the dialogue “calibration of sensors”.
In the “calibration of sensors” dialogue, process-related reference data of the connected
measuring chains (Pre-amplifier and sensors) is managed. This reference data is used to
ensure the correct functionality, the coupling of the sensors and the calibration of the
measuring card, during an automated process.
(See Details – calibration of sensors)

5.1.6.6 Configuration → Frequency mask
Depending on the Analyser4D version in use, this menu item may not be available.

Opens the dialogue, or the docking window respectively, “Frequency mask”.
Here frequency masks can be created and saved.
Note: Frequency masks allow the manipulation of data streams based on the
frequency. Certain frequency bands can be strengthened, others can be dampened or
completely eliminated. The frequency masks can be used during the creation of buffers,
to generate filtered copies of the original measuring streams.
The crack detection, also, uses frequency masks to eliminate perturbations and
interfering frequencies.

5.1.6.7 Configuration → Pattern recognition
Depending on the Analyser4D version in use, this menu item may not be available.

Opens the dialogue “Pattern recognition”
(See Details – Pattern recognition)

5.1.6.8 Configuration → OpenGL
The OpenGL display options are expert or developer functions. They have no impact on
the measuring data, or the function of the application, but influence the 3D display in the
view areas.

OpenGL is a sub-menu for changing the 3D display
on the monitor or in the view areas of the process
topology.
Draw triangles:

Sets the display to an area wide triangle-web display.
Use blending:

Image 5.15: Menu OpenGL configuration

activates the transparency mode of the display.
Draw simple points:

reduces the display to a simple point display.
Activate anti-aliasing:

activates the super sampling of the graphic card, which leads to smoother lines, which can look
thicker that way.
Activate monocolor mode:

sets the complete display to monochromic
Activate Lighting:

activates the lighting mode (Fast access: „Lighting“–Button exists in the main tool bar)
Track mouse light:

sets the lighting to the place in the process topology that has been clicked.
Possibly, some display options will (seem to) not work, depending on the display option
used for the current application.
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5.1.6.9 Configuration → Pixel colour threshold
There are 3 sub-items here:
• Red
• Yellow
• White
The threshold, where the colour scale changes from blue to red / red to yellow / yellow to
white, is set here. This way the colour scale of the process topology display can be set.
5.1.6.10 Configuration → Set-up
Opens the dialogue „Set-up“
All basic configurations, that influence the whole system and the standard configuration for
new projects are set here.
Attention! Certain configurations will be copied into the project settings, when a new project
is created. If they have to be changed in the current project, the dialogue Configuration →
Measuring parameters has to be used.
Furthermore, the setup window also includes service technician and developer functions, used
for calibrations and installation of the system.
(See Details – Settings)

5.1.6.11

Configuration → Start CiS Set-up assistant

Attention! This is an expert, or service technician and developer, function. The use of this
function changes all device settings and is not easily reversed.

Opens the CiS Set-up assistant.
The assistant is used to easily make the Optimizer4D system compatible with the CiS.01 for
use during bending and straightening processes.
The assistant activates the advanced functions of the Optimizer system related to the CiS.01
measuring system and is suited for the new installation of a bending and straightening
machine.
If a set of work piece parameters is to be imported from a CiS.01 device and a highest
possible backwards compatibility is desired, the File → Import CiS Settings function should be
considered.
5.1.6.12 Configuration → User management
Using this menu item will give you access to the user management.
5.1.6.13 Configuration → Data back-up
Opens the dialogue „Data back-up“

In the data back-up window a back-up of all system settings and project settings, as well as
the runtime statistics, can be done. The corresponding data will be compressed and deposited
in a back-up file (back-up archive).
The back-up file can be found in the folder /data1/backup/optiBackup. This directory
can be found on the hard drive for the first measuring channel. Should the base system, the
hard drive with the Linux operating system, have to be replaced, the data can be transferred
easily this way.
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The dialogue contains the following sub-options:
Network settings:

If selected, the network settings will be taken into the back-up.
Note: This function is not available in the current system (V1.75.24)
Optimizer4D settings:

If selected, the configuration files will be taken into the back-up.
Project Data base:

If selected, the complete MySQL data base, which contains all project settings, statistics, and
automation results, will be taken into the back-up.
This option has to be selected, if project files are to be transferred from one device to another.
Use Standard target folder:

The back-up will be saved into the standard directory. Otherwise, the new target directory can be set.
Attention! The file back-up does not save measuring data!

5.1.6.14

Configuration → Import back-up

This is a service technician function

Using this function a back-up file, which has been created using the back-up function ( Menu
→ Configuration → Back-up ), can be imported into the system. This way the exact conditions at
the point of the back-up are restored.
Attention! All current projects or settings will be deleted during the import.

5.1.6.15 Configuration → Activate administrator functions
Opens the authentification dialogue to access the administrator functions:
After entering the correct password administrator access to all program settings will be
granted. Not every function is available to every user.

Image 5.16: Dialogue – Activate Administrator functions
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5.1.7 Menu → Measuring

Image 5.17: Measuring-Menu

The menu „Measuring“ offers functions, that directly influence the kind and parametrization of the
measuring, currently being carried out. Furthermore, the trigger system, the automation and the
communication with the bus systems will be activated.
5.1.7.1 Measuring → Set preamp gain
Here the pre-amplification of the pre-amplifier for the currently run buffer is configured.
Usually, this is the pre-amplifier, which signal data is currently shown in the “view area” of
the process topology.
This way settings of the pre-amplifier can be adjusted during a measuring.
Note: This function is for easily finding a suitable pre-amplifier in unknown processes or
in a newly parametrized measuring. The central menu for configuring the pre-amplifier
is the multiplexer dialogue (Menu → Configuration → Multiplexer)

If no buffer is explicitly selected, the system will not find the port for the pre-amplifier, that is
to be parametrized, and will give an error message.
5.1.7.2 Measuring → Harddisk recording
Attention! Developer function.

Turns the automatic saving of measuring data on or off. Please note that a measuring without
harddisk recording depends on the available RAM. When no data blocks can be allocated for
the measuring data, the measuring will stop and give an error message. In the Optimizer4D
system the harddisk recording is always active.
5.1.7.3 Measuring → Enable trigger
This button (de)activates the trigger system.
When the trigger system is active the configured trigger list will be cyclically processed. This
way, only, can the system react to external machine control signals.
During automated processes the Enable trigger button is always active.
5.1.7.4 Measuring → Enable automation
This button (de)activates the automation.
When the automation is active, the different analysis modules of the Analyser4D application
(like crack detection, pattern recognition, or envelope surface evaluation) are started, or set
into standby respectively. This way, during the measuring, incoming data streams are
analysed, overstepped tolerance values are reported, and abnormal process behaviour is
recognized.
An activated automation is an essential condition for an automated operation of the machine.
Furthermore, the trigger system has to be activated to enable a communication of the
components, like automation, bus systems, SPC of the machine and the Optimizer4D system.
5.1.7.5 Measuring → Record I/O input
45

5.1 Menu functions
Activate Record I/O input to create an additional buffer during the measuring, which shows the
condition of the I/O signals. Every I/O signal gets its own track in the display.
Note: This function is obsolete, since the condition of the I/O signals is always
recorded. This recorded data can be viewed in the process topology with Menu
→ Display → Show Objects Activation status .

5.1.7.6 Measuring → Mark executed triggers
When this function is activated, the analyser4D software will set multiple marks in the
process topology, whenever a trigger is activated during the measuring.
5.1.7.7 Measuring → Fire default sensor pulse
Fires a default pre-amplifier sensor pulse. The port, intensity, and number of pulses will be
taken from the multiplexer dialogue settings.
This way, during a running measuring, short energy pulses can be created.
5.1.7.8 Measuring → Initiate preamp frequency test
Starts a self test of the pre-amplifier, which sends a 50KHz signal with a length of 100ms.
Should a measuring be running, the signal will be recorded. With this function the measuring
chain, from pre-amplifier to A/D converter, can be checked.
5.1.7.9 Measuring → Manual Sensor Test
Checks if a sensor is connected, and checks, should a reference be set, whether the detected
characteristic value graph is within the set tolerance. The test will be done for all preamplifiers, which are activated in the multiplexer options.
The settings for the sensor test can be viewed in the sensor calibration dialogue.
( Menu → Configuration → Sensor calibration )
(See: Sensor calibration)

5.1.8 Menu → Analyse

Image 5.18: Analyse-Menu

5.1.8.1 Analyse → FFT
With this function a Fourier-Transformation can be calculated on the basis of the currently
viewed process data. This will be shown in an additional, small window in the area of the
secondary
tool
bar.
„Analyse FFT“ is
low
frequency,
the
measuring

suited for finding,
periodic events in
signal and for

46
Image 5.19: Analyze: FFT
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finding beat frequencies. Should no data area be selected, the application will choose one
automatically (the one with the highest amplitudes), to calculate the FFT data out of 2048
spectra.
When an area has been selected, the FFT will be done with this data.
By clicking the desired signals or signal spikes in the control window, which opens next to
the secondary tool bar, the corresponding frequency can be checked.
This window can be closed with the right mouse button.
5.1.8.2 Analyze → Frequency maxima
This function opens an additional diagram in the secondary tool bar. There the maximum
amplitude of the currently viewed section of the view area is shown with a blue signal
gradient. Additionally, a red gradient shows the historically highest amplitude of the
frequency areas, which have been viewed before.

Image 5.20: Secondary tool bar Maximum Amplitudes

The window can be closed with a right mouse click. With a left click the maximum value
history will be deleted.
5.1.8.3 Analyze → Histogram
Attention! Function for developers

The histogram creates a frequency analysis of the occurring
amplitude values and shows this in an extra window. The
analysis is done with the whole process and can take some
time depending on its length.
The resulting graphic is only an optical summary and can
not be exported at this moment.

Image 5.21: Histogram

5.1.8.4 Analyze → Create Peak List
With this function you can check how often a signal oversteps a certain threshold, across the
whole process. For this, the help layer has to be raised to the desired level, by pulling the
sensitive y-axis.
(See Basics – work with data – sensitive areas)
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Image 5.23: Peak List 2

Image 5.22: Peak List

Afterwards Create peak list is opened and the application searches the whole process area for
times that the level of the help layer has been overstepped. This will be checked step by step
according to the set time basis. The result is a list, which can be saved as a CSV-file (Comma
separated values).
5.1.8.5 Analyze → Create FFT from signal
This function calculates the corresponding frequency data buffer from the signal data buffers.
This can be useful for imported signal data (or amplitude data) from other measuring systems.
Furthermore, it is possible to create FFT displays, which the measuring card can not create,
from the recorded signal data streams.
ATTENTION! This procedure can take a long time depending on the size of the signal
buffer.
Create FFT from signal

opens a dialogue, in which the frequency analysis (the FFT) can be

configured.

5.1.8.6 Analyze → Energy calculation
This is a developer function, that may not be available

With this you open a dialogue, in which the chronological energy chart is created in a
separate buffer and the energy thresholds, which will send a trigger signal when overstepped,
can be defined.
5.1.8.7 Analyze → crack classification
This is a developer function, that may not be available

5.1.8.8 Analyze → Pulse transit times
This is a developer function, that may not be available

5.1.8.9 Analyze → statistical functions → Open dialogue for statistical analysis
Allows a statistical assessment of processes over time.
(See Details Statistical tools)
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5.1.8.10 Analyze → calculate FFT Max. energy bands
Calculates the frequency bands of the whole selected buffer, which contain the maximum
energy and the maximum amplitude.
5.1.8.11

Analyze → Analyze average voltage amplitude

This is a developer function, that may not be available

When this option is activated, the frequency band, which contains the highest amplitudes in
relation to the currently viewed section, is continuously shown. At the same time, amplitudes
of directly neighbouring frequency bands are taken into account, as long as they are 10% of
the maximum amplitude, and are included in the resulting energy. Therewith the voltage is
calculated, which lays at the input of the pre-amplifier.
5.1.8.12

Analyze → preamp sweep tools

This is a developer function, that may not be available

Opens a dialogue, which allows setting the pre-amplification, at a measuring channel or the
pre-amplifier port, from 0 to maximum in definable steps and time frames. For this a new
measuring may be started.
5.1.8.13

Analyze → Search max. amplitudes in bands

This is a developer function, that may not be available

Creates a diagram of the maximum amplitude of a frequency band compared with the
frequency. Service technicians use this function, to determine the frequency response of the
sensors and the pre-amplifier.
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5.1.9 Menu → Tools

Image 5.24: Tool-Menu

5.1.9.1 Tools → Screen shot
With Screen shot a screen shot is taken of all visible view areas. A png-file is generated,
which is saved in the directory: /dataX/{projectname}/screenshot. So it is saved under
the standard directory of the current measuring channel.
Attention! The screen shot files will never be automatically deleted by the application. If
many screen shots have been taken, the directory has to be cleaned up manually.

5.1.9.2 Tools → Data collection
With help of the function Data collection cuttings of different buffers can be assembled into a
new buffer. For this the desired data cuttings have to be marked in
each source buffer by using Selection in the tool menu. Afterwards
the option Data collection has to be used. A new buffer will be
created, which is called „Data collection buffer“.
This procedure can be done as often as desired. Each selected area
will be added to the end of the data collection buffer. The Image 5.25: Data collection
parametrization will always be taken from the first transfer. Data with, for example, different
sample rates will be contorted.
5.1.9.3 Tools → Set Help project
Some functions need a defined help project, to be able to do some features, like special export
functions. An example is the Divide buffer function.
With a click on the menu item you can select the help project from the dialogue. An existing
project is necessary; if needed an empty project has to be created for this.
5.1.9.4 Tools → Split Buffer → Help project (current)
Splits buffers into predefined parts and creates a new process un the help project out of each
part. The source is the currently viewed buffer of the current process.
5.1.9.5 Tools → Split Buffer → Help project (all)
Same as Split buffer → Help Project (current), with the difference that at the end of the buffer
the system switches to the next process to create a buffer with an identical type.
5.1.9.6 Tools → Edit enumerators
This is a function for experts and service technicians

The current reading of the enumerator will be saved for every single process when the process is
finished. In the dialogue, which will be opened by choosing Edit enumerators . You can change the
reading of the enumerators afterwards in a freely definable process number zone .
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5.1.9.7 Tools → Save playback as video
When this option is set on active, a video of the process will be recorded instantly by clicking
on „Play“ on the control bar at the bottom right. Click again to stop the recording. The video
is now saved in the video index at this location: /dataX/{projectname}/video. The video
contains the cutting of the process topology view area (graphic area), and the current
combined selected buffer.
Leave the video recording function activated only for as long as you really need it. Otherwise
it can happen that you generate long videos by mistake and that your disk space will be used
unnecessarily.
5.1.10

Menu → Quick

Attention! This option is only available for file system based projects.
The menu Quick offers a quick access function for several projects. You can enroll five
projects, which can be rapidly chosen and loaded by the name and by clicking the buttons
from F5 to F9.

Image 5.26: Quick-Menu

The programming of the project is possible if you click on „Menu → File → Load Project“. Then
you choose in the sub-item „Programming Mode“ in section „Quick“ (a check will appear in front
of both) the saving location for your project.
A response is telling you now that your project was successfully registered in the specified location
and that you open it by using the function buttons.

5.1.11

Menu → About Analyzer4D

Image 5.27: About-Menu

5.1.11.1 About → Information
Opens an information-dialogue with the address of the QASS GmbH.
In addition you can find the name and user level of the currently logged
in user.

Image 5.28: About Information

51

5.1 Menu functions

5.1.11.2 About → Information about version
Here you can find several information about
the version of files and programs or rather of
the kernel module version of the used
software and of the Optimizer4D system.
Furthermore the gathered information is
located here, which is provided by the kernel
module and which is important for the
development support team.
.
Image 5.29: Dialogue Information about version
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5.2 Tool boxes
5.2.1 Main tool bar – Monitor
The main tool bar is located on the right edge of the screen besides the graphics
window (the view of the process landscape)
5.2.1.1 Click mode button
The upper the buttons MOVE ,
the touch screen control:

ROTATE

and

ZOOM

are specifically relevant for

The selection buttons control the tenor function of a click on the screen.
Because different mouse buttons are not available, the different click modes
have to be realised alternatively.
This happens with a click on the desired (mode) button.
activates the moving mode
ROTATE activates the rotation mode
ZOOM enables zooming in or out of the area
MOVE

5.2.1.2 View holder
The view holder buttons provide fast access to the different viewing
angles and view configurations of the view area. It is possible to use defaulted
viewing angles or define own ones as well.

Illustration 5.30:
Main tool bar
monitor

Illustration 5.31: Time axes display (X-Y-view)

Sets the x-y-view (time axes display). The graph appears two-dimensional, because
you are looking at the amplitude of the signal exactly from the side.
Sets the x-z-view (bird's eye perspective, frequency display). This makes the graph
appear two-dimensional and it seems like a profile view or a histogram. The height of the
amplitude can only be estimated by the colour.
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Illustration 5.32: Frequency display, bird's eye perspective (X-Z-view)

These buttons can be configured.
You can deposit user defined views here.
Register view: Click the button with the right mouse button. This saves the current view of
the active view area.
Set and recall view: Click the button with the left mouse button.
5.2.1.3 Tool box
These buttons (de-)activate further tool boxes in the side tool bar, which is located
under the view areas, respectively the navigation time line.
These are in detail:
• Process
• Selection
• Buffer work
• Recording
• Automation
• Video
See respective chapter for the explanation of the functions in the individual tool boxes.
5.2.1.4 Lighting
Switches on the lighting in the active “workspaces“. This increases the contrast and
enables a better structure detection. (If a great amount of data is displayed, the display speed
decreases.)
5.2.1.5 Colour scale
Calls a parameter wheel which helps to move the colour scale of the display.
Especially when the signal is weak and the signal amplitudes are very small, the readings can
be highlighted with more intensive colour grading.
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Illustration 5.33: Colour scale

5.2.1.6 Main sector scale
By using the parameter wheel you can scale the display of the amplitude height (yexpansion of the process landscape).

5.2.2 Tool box buffer

Illustration 5.34: Tool box: Buffer
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This tool box provides tools for the analysis work in the individual buffer. If the tool box is
not visible at the moment, it can be activated with the tool box button “Buffer“ in the main
tool bar on the right.
5.2.2.1 Maximum level search - Peak search
With this function you can determine the appearance of the respectively tallest
amplitude in a certain area.
This function is designed as forward search and as backward search.
The forward search seeks the tallest amplitude that lies after the currently shown process
section in time. The backward search respectively seeks the tallest amplitude that lies before
it in time. In the navigation bar you can identify the current position and the size of the image
detail based on the area shaded in blue or the green brackets.
The function of the “Peak search“ button slightly changes when a help layer is activated
during the usage:

Illustration 5.35: Peak search

Now not the tallest amplitude is sought, but the point on the time line, where the amplitude
breaks through the help layer for the first time.
5.2.2.2 Shift Ref
This function turns on the moving mode for the reference plane (see also: “Area
Box“). Accordingly, a reference plane has to be activated in the current “View area“ on the
monitor to use this function.
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Illustration 5.36: Shift Ref. example
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If no reference plane is activated, an error message will occur to remind you of it:

Illustration 5.37: Warning "No Ref. layers"

When the “Shift Ref“-key is activated, the function in the navigation bar changes: Not the
entire signal is being moved, only the signal within the range of the activated reference plane.

The sensitive x-axis (time axis) now refers to the reference plane.
5.2.2.3 Reset shift
Resets the value by which the reference planes have been moved relative to the main
signal level to 0.
5.2.2.4 Real-time Diff (Real-time signal difference)
Note! This function may not be available depending on the applied Analyzer4D version.

Shows the differential signal of two signal level. For this a reference plane also has to
be activated. Activating the button “Real-time Diff“ delivers a display of both original

Illustration 5.38: Buffer work - Realtime diff

signals in grey shading and the resulting differential signal on the main signal level.
The original signal can be switched off by clicking on the “View area“ boxes, so that only
the pure differential signal is visible.
5.2.2.5 Calc Min (Minimum level detection)
Note! This function may not be available depending on the used Analyzer4D version.
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Illustration 5.39: Minimum level selection

The function “Calc Min“ searches for the minimum value in the selected data area
of the process in each frequency band to use it as a negative offset for the display. In this
context minimum value means “smallest amplitude“.
This function is suited for the elimination of background noise bands. It does by simply
selecting a process section where the background noise occurs isolated and then applying the
“Calc min“ function. Once the minimum amplitudes are calculated, they can be turned on or
off in the display with “Show min“.
5.2.2.6 Show min (show minimum suppression)
Note! This function may not be available depending on the used Analyzer4D version.

If the “Show min“ switch is activated, the offset calculated by “Calc min“ is
subtracted for the signal display. If it is deactivated, the original data are visible.
5.2.2.7 Threshold, Ref. Signals, Analyze, Show Shift
More about these function in the chapter “Analyse”.
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5.2.3 Tool box Process

Illustration 5.40: Tool box Process

The process tool box contains (navigation) elements that mainly serve the purpose of navigating the
different processes of a project. A process is an individual, concluded measuring.
5.2.3.1 Prior process
Sets back the current display of a process (thus, calls the prior process).
The current process number is displayed on the process quick select button.
5.2.3.2 Next process
Increases the current process number by 1 (meaning, it calls the next process).
The current process number is displayed on the process quick select button.
5.2.3.3 Process quick select
The current process number is display on the quick select button
which is located between the blue arrow keys.
By clicking on this button you open the virtual keyboard, where you can
enter a process number. Entering the number with the keyboard can be done
by typing in the number in the input field or by using the number buttons.
Confirm with “Enter“. Now, the process with the respective number is being
loaded and displayed in the process selection button.
Note: The entered number has to be the number of an existing process.

Mouse control: Clicking the right mouse button opens a dialogue that
allows you to select a process based on its creation date and time.

Illustration 5.41:
Dialogue: Process
selection via time

5.2.3.4 Swap
Activating the “Swap“ button will enable you to switch between the two last loaded
processes.
To compare two processes, process 1 is loaded with the “process quick select“ function. Then
the same thing happens for process 2. Now, you can switch between the two selected
processes in the “view area“ by using Swap.
5.2.3.5 Process memory mode (MEM)
The “process memory mode“ is the automatic process view storage mode. If the
check box beside “MEM“ is checked the application remembers the temporal position as well
as the temporal expansion of the current view (thus, position in the “time line“ and the setting
of the “time base“). If a process is selected anew, you will get the view that applied for the
last display of the process, respectively for the change of the process of project.
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If MEM is not checked off the current temporal position and the value adjusted in the “time
base“ remain through the change of the processes.
5.2.3.6 Enter comment
When you click on

Enter comment

a virtual keyboard appears on the screen.

Illustration 5.42: Comment function – Virtual keyboard

With the use of this keyboard you can deposit a comment about the currently displayed
process. The comment will show in the current “view area“ of the process on the monitor. It
is located on the left and is displayed in yellow letters.
Note: The comment are NOT saved automatically. This only happens when you save the
project. (Menu File → save project ).
5.2.3.7 Save
With “Save“ the buffer information of the current “view” are saved. The layouts of the
individual signal view areas (main layer, both reference layers) and their parametrisations are
stored here.
If the process is swapped and then recalled the data is available the way it was at the time you
left the view.
5.2.3.8 Restore
Restores the saved process view configuration (for the current process).
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5.2.4 Tool box Selection

Illustration 5.43: Tool box selection

In case the tool box is not visible you can activate it in the main tool bar on the right with the button
Selection .
With the help of the “tool box selection” you can choose areas in the process. You can select them
by the time- as well as by the frequency-axis.
5.2.4.1 Select
Activates the selection mode by deactivating the moving- and rotation functions of the view
area. Then, a click in the process area activates a selection cross-hairs that can be moved with
the mouse.

Illustration 5.44: Selection cross-hairs

The viewing angle, thus the view on the process landscape, is crucial for this procedure
(especially the rotation angle):
• View on the time line: A time range is selected. (see illustration)

Illustration 5.45: Selection of a time area

•

View on the frequency axis: A frequency range is selected (see illustration)
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Illustration 5.46: Selection of a frequency area

If both actions are performed consecutively a rectangular area appears that stretches out in the
time axis/frequency axis layer and selects part of the process landscape.

Illustration 5.47: time frequency selection

The determination of the selection borders while holding the Selection button goes as
follows:
A click in the layer of the process landscape with the mouse button, without releasing the
mouse button, shows a cross-hairs that can be moved for as long as you are pressing the
button. To fixate the final position, just release the mouse button.
You repeat this procedure a second time to set the second border.
Analogous to this you can control via the touch screen. The selection is fixated on the
position where your finger left the display.
Note: If the program is operated with the mouse and not touch screen, there is a fast option to
mark the area: Clicking with the middle mouse button inside the process selects the upper left
edge of the area to be marked. Afterwards you can draw a rectangle around the whole area
that you want to select. If you now release the mouse button, the selection is complete.
5.2.4.2 Delete
To reverse a prior selection, click the

Delete

button in the “selection tool box”.

5.2.4.3 Hide unselected
This selection option hides the data area that has not been selected, so that only the selected
data area is still visible. The rest is completely hidden.
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Illustration 5.48: Hide unselected – hidden data area

Hide unselected

can be called via the menu

View → Selection → Hide unselected.

Note: This function is only available after selecting the data area!

5.2.4.4 Zoom to...
Zoom to maximises the selected area, so that it is stretched over the whole “view area” (Zoom
into the selection)

Illustration 5.49: Active data selection
Zoom to

See also

Illustration 5.50: Zoom to selection

can also be called via the menu

View → Zoom to selection

View → Toggle zoom

Note: This function is only available after selecting the data area!

6
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5.4 Settings
You can find the settings dialogue, also “Set-up” dialogue, in the menu

Configuration → Settings

.

In the “Settings” dialogue, or the “Set-up”, all settings that have validity in the whole application,
are configured. You also define project parameters here, that count as the guideline settings for new
projects.
The dialogue is divided into several main sectors that you can select by clicking the respective tab
on the top:
• General
• System
• Disk I/O
• SQL Database
• GUI (graphical user interface)
• Measuring
• Scanner
• CIS Emulation
• Video
• Network
• Parameter
The confirm-buttons are available in every section.
Applies all changes in the “Settings” dialogue without closing the window.
Applies all changes in the “Settings” dialogue and closes the window.
Sets back all the changes to the values that where valid when you activated the
dialogue, or closes the window without applying the changes.
5.4.1 Settings - General
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Illustration 5.51: Settings - General

5.4.1.1 Monitor channel, Sample rate, oversampling, windowing function
These parameters are also available in the dialogue “Multiplexer”. Look there for the
explanation of the function.
5.4.1.2 Frequency resolution
The option “Frequency resolution” shows the amount of discrete frequencies that result
from the Fourier transformation. At the moment this value is set to 512. With later versions of
the Analyzer4D application it will be possible to change this value.
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5.4.2 Settings - Disk I/O
Here you set the file paths where the Analyzer4D program stores the individual channels and the
project data. Also, there are further options in this tab that deal with data management.

Illustration 5.52: Settings - Disk I/O

5.4.2.1 Data base directory (Ch1 ... Ch3)
“Data base directory” is the basis data register in which the sub directories of the
measurement data and the individual projects are created.
Note: Here, the settings for the Optimizer4D system are “/data1/”, “/data2/”, “/data3/”

The path names behave according to the conventions of a Unix file system.
Only the administrator is allowed and able to change the file paths. To do so, you have to
check the switch “Change path names”. This activates the individual fields of the input
options. Now you can enter the respective path name directly into the input masks. The entry
can be done with the virtual keyboard. To activate it, click the keyboard symbol that is on the
right side of the path name.
The application generates the following directories when a new project is created:
“x” stands for the channel number of the channels 1 to 3.
“project” is the current project name
•
•
•
•

{base directory x}{project}/buffer{x}/
{base directory x}{project}/raw{x}/
{base directory x}{project}/info/
{base directory 1}{project}/screenshots/

Compressed buffer files
The raw data (measuring data)
Information files
The *.png picture files of the screen shots

Example: The project name is “TestProjekt”.
/data1/TestProjekt/buffer1/
/data2/TestProjekt/buffer2/
/data3/TestProjekt/buffer3/
/data1/TestProjekt/raw1/
/data2/TestProjekt/raw2/
/data3/TestProjekt/raw3/
/data1/TestProjekt/info/
/data1/TestProjekt/screenshots/
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5.4.2.2 Project directory
“Project directory” is the register where the individual project files are stored.
Note: The default in the Optimizer4D system is “/home/opti/Projects/”

Only the administrator is allowed and able to change the project path. To do so, you have to
check the switch “Change path names”.
5.4.2.3 Video output path
A specific option is offers the possibility to compute a video of the process. You can find the
settings for this under “Video output path”. Here you can configure the directory where the
video data are automatically exported to – the new film is created in this directory.
Note: The default of this path in the Optimizer4D system is “/home/opti/videoout/”

To render the content of the monitor frame into a movie, the switch “Save replayed frames”
has to be activated
See also chapter “Play movie”

5.4.2.4 Save replayed frames (create film)
This option activates the film mode of the play function in the monitor view. At that, the
display of the process landscape is being converted into a video (format *.wmv) during the
replay and saved in the directory configurable under “Video output path”.
See also chapter “Play movie”

5.4.2.5 Load last project on application start
A check in the control box “Load last project on application start” activates the automatic
reading of the project that has been active last on program start, respectively the start of the
Optimizer systems.
5.4.2.6 Enable multi path
“Enable multi path” activates the distribution of measuring data of a single channel to
different hard drives, thus different “Data base directories”. This function makes it possible
to perform long measuring processes that are distributed to all integrated hard drives
afterwards. At the moment this option cannot yet be selected. It will be in future versions of
the Analyzer4D program.
Note: This function is not available if you are measuring on more than one channel.

5.4.2.7 Process overwrite interval
This function enables the user to record a lengthy measuring with a lot of individual
processes that would usually far exceed all of the available hard drive slots.
By activating the “Process overwrite” function, all the oldest processes of a lengthy
automatic measuring are deleted as soon as there is no more hard drive space available or it is
running short.
At that, the nth process is always being retained, depending on the setting – n is the number
selected in the selection field.
See also chapter “Long measuring”.
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5.4.3 Settings - System

Illustration 5.53: Settings - System

5.4.3.1 Default buffer compression algorithm
Set the method which shall compress the raw data during the measuring.
When the measuring is performed, 2 buffers are automatically created from the raw
signal data, which simplify the subsequent navigation in the data. This is the buffer wth
the “moving average” for one and an additional buffer whose compression type is set
with this option.

The following compression types are available:
• Down-sampling
• Maximum
• Moving Average

See also “Data Types” and “Buffer”

5.4.3.2 Default compression factor
This option provides the possibility to pre-set the efficiency of the compression, that can be
applied for the calculation of compressed buffers from raw data (during the measuring by
selecting “MenuBufferCreate compressed buffer”
Example: If you enter the value 16 here, the compressed buffer will have one sixteenth of the signal
data size of the original raw data buffer.
ATTENTION! If a very small compression factor is selected it can happen that the
storage overflows. For a long measuring (more than 3 minutes) the compression should
never be below “32” and for a measuring that is even longer it has to be adjusted
accordingly!
See also chapter “Data Types” and chapter “Buffer”

5.4.3.3 Auto navigation buffer (Automatic buffer selection of the time bar)
In the navigation bar a process overview of the buffer that is selected in the “Area Box” is
displayed by default.
Although, the navigation cannot display raw data buffers because the amount of data would
be too great.
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When the “Auto navigation buffer” is activated, the navigation bar is able to automatically
use a different (compressed) buffer for display, if a raw data buffer is selected in the “Area
Box”.
If no similar buffer can be found, the process overview in the navigation remains empty.
It is recommended to activate this setting.
5.4.3.4 Auto anti-aliasing
This function activates the automatic calculation of maximum buffers in the monitor view,
which is tailored to the current value of the time base. The advantage of this is that short,
impulse-like signals can also be detected in large time windows.
Background: The fresh “Down-sampling” ensues by force due to the display of the 3D
functions, because there is a limited amount of averagely 1024×768 pixels on the
screen while the number of the spectra to be displayed can easily climb to tens of
thousands. This is why significant signals can easily be “overseen” or the display
“flickers” when scrolling through.
Attention! If the amount of spectra to be displayed is smaller
than the screen resolution that is available or a raw data buffer
is selected, the anti-aliasing process is not performed.

It is recommended not to activate this function as standard.
The anti-aliasing process can be activated manually by operating
the space bar for the current “View area”.
An “(AA)” in the “Area Box” indicates that an anti-aliasing buffer
is being displayed.
Illustration 5.54: Anti-aliasing
active

5.4.3.5 I/O block 4 is input
If “I/O block 4 is input” is checked, block 4 will be configured as input.
Then there will be 24 inputs and 8 outputs available.

The Optimizer system provides an interface to a potentially existing PLC machine control. This
interface consists of 4 blocks with 8 input-/output lines each.
Block 1 and 2 (Signal lines 1-16) are set as inputs.
Block 3 (Signal lines 17-24) is set as output.
Block 4 (Signal lines 25-32) can be set as either input or output.
The switching voltage amounts to +24V.
The input blocks have to be connected to the external PLC mass (Pin 10).
If the ouput signal lines are to be wired, an external +24V supply voltage (from the PLC) has to be
set up. (Pin 21 = Pin 1 into Block 3)

The default configuration provides 16 inputs and 16 outputs.
See chapter “I/O-inputs” or “SPC-Connection”
NOTE: You also can find information concerning this in the “Technical Manual”!

Illustration 5.55: I/O interface (PLC) Optimizer4D
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5.4.3.6 View holder eyes restore start time and time range
Changes the behaviour of the view holder (
) in the main tool bar. If this option is
activated, the view holders store the start time as well as the time range of the displayed
process section, additionally to the viewing angle.
5.4.3.7 Kernel module debug level
This option sets the number of system reports of the kernel module.
“0” stands for “no messages”. This is predetermined – the higher the adjusted value, the more
prompts the kernel module sends.
ATTENTION! Debug level greater than 2 can cancel a measuring. It is recommended to
only activate this option for testing purposes
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5.4.4 Settings - GUI
The settings for the graphical user interface:

Illustration 5.56: Settings - GUI

5.4.4.1 Show transparent selection walls
Activates transparent areas during the selection in the
“View areas” with “Selection”. They are being displayed
in the current selection position, to visually emphasise that
very position.

Abbildung 5.57: Transparent selection wall

5.4.4.2 Show transparent plane in y-scale help layer
This function activates an additional transparent area in the
vertical help layer of the monitor view.

Abbildung 5.58: Transparent yscale layer

5.4.4.3 Do not dim selected areas
This option prevents the dimming of the inactive “View areas” in the monitor view.
The active area is still marked by the green letters “VIEW #2” in the area box, while a the
name of a selected area is marked red.
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5.4.4.4 Mark settings
Configure the look of the selection in the process landscape.
Show flags
Displays little flag symbols at the positions where a mark is set.
Show lines
Sets up the connecting lines between the marked position and and the
text description box
Flag size
Adjusts the size of the flag
See also chapter “Marks”

Illustration 5.59: Mark
settings

5.5 Multiplexer
In the multiplexer dialog you prepare your measuring process by configuring the preamplifier as
well as the recording channels.
Select this dialog via the menu “Configuration → Multiplexer”.

Illustration 5.60: Multiplexer Dialog – Port setting-mode

If you intend to use the measure positions you can configure them in the multiplexer dialog as well.
Measure positions provide the possibility to change measuring parameters or to switch
the configuration of the active evaluation module (e. g. the crack detection module) in
an ongoing measuring.

The button “Show measure position / Show ports” switches between the port setting-mode and the
measure position mode.
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Illustration 5.61: Multiplexer Dialog – Measure position-mode

5.5.1

Port setting mode
On the left side you will find Settings for available channels (Channel 1–4).
Note: The number of the displayed or adjustable channels depends on the respective
features of the Optimizer4D system.

On the right side are the tabulators “Preamplifier 1-8” and “Preamplifier 9-16”. This is where
you configure the pre-amplifiers that are connected to the Optimizer4D-ports.
More setting groups and function can be found underneath.
Note: Depending on the program version and its user rights, some options are either not
available, greyed out or not visible.

5.5.1.1 Measure settings
Assign 24bit A/D:

If your Optimizer4D is equipped with a second generation measure card you have the option of
using a 24bit A/D converter (which allows a much better resolution of the measure values) instead
of the defaulted 16bit A/D converter. While the preset 16bit converter has only enough capacity for
a sampling rate of up to 25MHz the 24bit converter allows a maximum of 4MHz.
The setting Assign 24bit A/D activates the 24bit converter for the selected measuring channel.
The changed sample rates will be displayed in the channel settings.
Monitor channel:

With this setting you select the channel that is shown in the process landscape display at the start of
a new measuring. Currently it is not possible to do a live display of more than one channel.
ATTENTION! The selected channel should match one of the configured channels. If the
Optimizer4D is only equipped with one DSP module (for one measuring channel) you
always set channel 1.
Background: During the measuring the process landscape is shown in the process display and
screens a sector of the latest measurement data. The size of the observation window matches the
selected time base.
Note: The time base should not be set too big. A good value is 1s. This value is set automatically with
the measurement start.
Move I/O Trg:

Delays the I/O-object-trigger by the value set in the numeric keypad.
This is a service function that is not required for normal operating.
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5.5.1.2 Special preamplifier command:
This allows to send a random character string and test the cable rest function of the
preamplifier. These functions are primarily intended for developers and service technicians.
5.5.1.3 Impulse test
Here you can find the default settings for the testing impulse. External triggers that release a
pulse access this setting as well.
Preamplifier:

The preamplifier (port) to which the impulse test is sent.
Pulse amplification:

Here you can set the charge of the sensor pulse. 0 is the maximum value. Whereas 4095 is the
minimum value. The higher you set the value, the less energy the impulse will generate.
Pulse counter:

This many pulses are generated by triggering the function just once.
Send pulse command:

The sensor impulse is triggered

5.5.1.4 Measure setting dialog
The button Measure Parameters Dialog activates the measure setting dialog specific for the
project.
Here you can for instance set the creation of compressed data streams (buffers). The dialog is
also accessible through the menu under Configuration → Measuring parameter.
See also dialog: Measuring parameter

5.5.1.5 Save as default
Save as default copies all of the current port settings or measuring position (depending on the
view mode) into the default settings.
Afterwards every newly created project will have exactly these settings.
5.5.1.6 Load from
Load from opens a project range dialog from which the port settings can be loaded. This
allows to apply the configurations from a project that already exists.
5.5.1.7 Detect connected pre-amplifiers
If this function is running all inputs are checked for a connected preamplifier. Thus the grayed
out status of the port numbers is reset in the preamplifier section for every connected
preamplifier.
Preamplifier that are not connected to the device will appear in grayed out numbers, where
the number of connected pre-amplifiers will appear much more distinguishable.
Note: For every detected pre-amplifier there will be a pre-amplifier-firmware-version
displayed in the message window.
If the connected pre-amplifiers have changed or standard pre-amplifiers have been
swapped for another multi input pre-amplifier, this function should be dialled.

5.5.1.8 The message window (Multiplexer information area)
The message window (downright) shows the communication between the pre-amplifiers and
the Analyzer4D application. Commandos that the application sends to the connected preamplifiers are shown here as well as the feedback.
Attention! Red messages implicate an error in the communication!
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In this case the links of all connected pre-amplifiers should be checked as well as the
parametrization you performed. Perhaps you are trying to dial a port that is not connected to a
pre-amplifier.
But the corresponding pre-amplifier could also be faulty. When possible, test another preamplifier with the same input.
5.5.2 Channel scheduling (DSP)
In the channel groups you link channels with multiplexer ports –
and therefore with the pre-amplifiers. This is done for each of the
four channels in the expanding buttons inscribed Preamp port.

Illustration 5.62: Channel
Configuration

“DSP” stands for “Digital signal processor” – these are the analogue to digital converters on the
measuring card. A port can be assigned to each DSP chip. This port matches the pre-amplifier ports
of the Optimizer4D.

Illustration 5.63: Pre-amplifier ports (Preamp-Ports,
Multiplexer-Ports)

At the same time the channel settings determine how many measuring channels will be
activated during the measuring. E.g. two configured channels mean that the device measures
on two channels. At that the measuring data is being put in the corresponding directory of the
channel, according to the configuration in the current project respectively in the Defaults .
ATTENTION! If all channels are set “unused” either the measuring cannot be take place
or an error message occurs.
Each pre-amplifier port on the Optimizer4D has a green and a red LED-display which show the
status of the respective input. A green light means that the port is activated and has been assigned
to a measuring channel.
ATTENTION! If a red light flashes at one of the pre-amplifier ports the configuration of
the either measuring channels or the pre amplifiers is not in order and has to be checked.
It is advised to check the ports LED display before each measuring.
Note: Depending on the configuration of the Optimizer4D system not all channels have
to be available. DSP channels that are not available are usually not displayed unless you
are logged into administrator mode or you have a high user level
Note: The Multiplexer module with the inputs (ports) 9-16 is an optional extra and not
available on every Optimizer4D.

Data mode

You can choose between two data modes: Mark FFT with a check to lay down measuring
data as a process landscape (frequency measuring); tick Signal to measure and display the
raw signal without frequency analysis (signal measuring).
Show setting

A click on Show settings extends the channel setting for further
features like sample rate, FFT oversampling and others:
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Illustration 5.64: Extended
channel settings
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Sample rate

The sample rate is the true sampling rate during the measuring. The maximum sampling rate
is 25MHz. The latest Analyzer4D version limits the sampling rate to 25MHz.
Note: The highest frequency to be actually measured equals half of the sampling rate.
This means that the signals of the Optimizer4D that go up to 12.5MHz can be measured
and displayed.

In most cases a sampling rate of 1600KHz is sufficient.
The Optimizer4D system has been improved for the mechanical vibration measuring on cutting
machines. The harder the processed material and speed of operation the higher the expected
maximum signal frequencies.
With frequency measurements (FFT data mode) it often pays off to reduce the sampling frequency
and instead increase the oversampling (FFT oversampling) to get a better temporal resolution of the
measuring signals.
FFT oversampling

While the frequency measuring is running, you can join the oversampling. This can be done
in the setting option FFT oversampling . The sample rate sets the highest measurable frequency;
the oversampling affects the number of spectra per second.
The higher the oversampling the more spectra you will get and the greater the data density
will become.
Note: During a mere signal measuring the setting

FFT oversampling

is being ignored.

During the Fourier transformation the original signal data is being worked on in blocks and added
step by step to the transformation in which the signals are disassembled into its frequency
components. This is how the typical picture of the process topology develops.
When the oversampling is activated the signal data is not simply calculated block by block but the
individual data blocks overlap. So, with oversampling=2 each reading is being included in the
calculation 2 times, with oversampling=4, 4 times accordingly.
FFT Window function

Here you can set the filter function that is being used during the Fourier transformation.
There are two options:
• Hanning (Cosine bell curve window) (defaulted)
• none
Background: For the Fourier transformation it is presumed that the signal section that is passed on to
the transformation is periodic and will perpetuate in this form forever. Of course it does not happen
like that because we only view small sections of a constantly varied incoming signal.
This causes an error that is reflected in the frequency data. Spectral lines that did not have any part
in the original signal can occur. To counteract this phenomenon there are various window functions.
The Optimizer4D implements the so-called Hanning-window (Cosine bell curve window).
This function only works effectively for the frequency measuring (data mode FFT).
FFT Logarithm

The logarithm determines how strongly high amplitudes are dampened in the frequency
display and therefore how much low amplitudes are lifted. The setting 1 dampens the most
16 the least. The default of 14 should deliver good results for most applications.
The setting 0 deactivates the logarithmic function so you will get linear amplitude data.
Note for the Optimizer4D with a second generation measuring card: deactivating the
logarithmic function changes the data format and doubles the data rate of the measured
bit stream.
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Usually a FFT amplitude has a maximum size of 16 bit. This is 2 bytes per value.
The amplitude resolution for linear data is lifted to 24bit. Thus 32bit values – 4vytes/value have to be gathered for the storing.
Something similar applies to the 24bit converter. Here the linear value range amounts to
30bit.
Object trigger bit

The trigger propped object detection uses the signal of a signal line to mark a time scale in the
frequency display.
Here you can set which signal line it concerns.
The mark with the green frame is mainly for the visualisation of the processes more
significant sections.
Currently there is no way of actively interfere with the automation control per object trigger
bit.
5.5.3 Pre-amplifier 1-8 / Pre-amplifier 9-16
Use the tabs Preamp 1-8 and Preamp 9-16 to access the settings of the pre-amplifiers at the
ports (the pre-amplifier ports of the Optimizer 4D system).

Illustration5.65: Pre-amplifier settings

Here you have to activate the pre-amplifiers that are due for the measuring. Which preamplifiers are depends on the channel configuration of the channel groups ( Channel 1 to
Channel 4 ). Generally the number of the activated pre amplifiers should equal the number of
the configured channels (thus not be set “unused”).
ATTENTION! If a red light flashes at the Multiplexer ports (preamp ports of the
Optimizer4D system) the configuration of the respective pre-amplifier or channel is not in
order. Perhaps it was selected in the channel groups but not activated; or activated but
not selected. However there are complex configurations which can mistakenly signal a
faulty parametrisation by flashing a red LED.
Example: A measuring is conducted on channel 1 while using port 6. The measuring parameters are
selected in the left column in Channel 1 (DSP 1); where the number 6 is selected as Preamp port.
In the tab Preamp 1-8 you check Port 6.

Furthermore you can set the input sensitivity – thus the pre-amplification –
individual pre-amplifier.
This is done with the spin control below the pre-amplifier activation field.
See also: 78

of each

Note: A pre-amplifier level of 0 has no impact on the connected pre amplifiers. The
amplification remains on a medium value which is automatically preset with the
activation of the pre-amplifier.
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Additionally you can activate a filter function for each pre-amplifier to limit the frequency
range. Please read about the exact data of the filters corner frequencies in the data sheets of
the pre-amplifiers
Often there appears machine noise in a low frequency range that shows a high amount of energy
and can overdrive the pre-amplifiers which is to the disadvantage of the actual useful signal from the
toll contact. This is why the lower frequencies can be filtered out with this function.

If the pre-amplifier is already activated the settings of the so-called Preamp gain – thus of the
pre-amplification – and the ones of the filters are directly sent to the pre-amplifier once
changed. This is helpful to change the pre-amp-parametrisation during a running measuring.
Otherwise the settings are not assigned until Apply or Apply & Close are actuated.
5.5.3.1 logarithmic / linear pre-amplifier levels
The Analyzer4D application knows 2 different modes:
Logarithmic pre-amplification (standard)

The gain value, thus the pre-amplification, which is being set in the pre-amplifiers contains
the adjustment range 0 – 6400.
This value does not describe the effective pre-amplification but is solely for the display of
arbitrary values being used. At that 6400 equals about times 550 the electric preamplification.
The correlation between the pre-amplification value and the actual pre-amplification is
NOT linear but depending on the characteristic lines of the pre-amplifiers electronics.

Therefore a doubling of the pre-amplification value of 1000 to 2000 does not equal the
doubling of the signal level.
Linear pre-amplification

This mode can be activated by the service technician. Depending on the pre-configuration
done by QASS and the application the linear pre-amplification could already be active.
The pre-amplification contains the accommodation 0-28000. 28000 equals about times 550
the electric pre-amplification at that and the correlation between pre-amplification value and
electric pre-amplification is linear.
Note: Potentially the maximum pre-amplification value described here can not be
selected. In the default dialogue → tabulator measuring the highest acceptable preamplification value can be limited.
Attention! Please do not confuse the logarithmic pre-amplification with the logarithmic
measuring. The logarithmic measuring affects the amplitude data of the frequency
calculation while the logarithmic pre-amplification only affects the actual signal level of
the input signal.

5.5.4 Multiplexer parametrisation example
The following example requires an Optimizer4D system that has a least 2 measuring
channels.
Measuring on 2 channels:
Channel 1 = Preamp-port 1
Channel 2 = Preamp-port 3 (additionally the filter is activated)
Sample rate = 6MHz
Oversampling = 4x
FFT window function = Hanning
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Illustration 5.66: Example "Channel config"

5.5.5 Mode Measure position
The Analyzer4D software supports dynamic
changes of the measuring settings during the
running measurement. Therefore the concept
of the measuring position. In the process
trigger commands activate or switch the
measuring position.
There are 16 measuring positions with
different settings to be chosen from.

Illustration 5.67: Multiplexer – measuring positions

The parameters per measuring position in detail are:
Mpos X Port:

Here you choose the port in which the pre-amplifier in use is plugged into.
This option enables you to switch from one pre-amplifier another and therefore from one sensor to
another during the measuring. This makes it possible to scan different positions in the process with
different sensors.
Pre-amplification value:

Here you can set the pre-amplification for the selected preamp port.
This option enables the dynamic adaption of the pre-amplification over the length of the process.
Channel:

Here you can set the channel for which the measuring position is validated. The channel has to be
activated in the Multiplexer settings.
C-Def Id: (Crack definition Id)

For the duration of the activated measuring positions there is the option of activating crack objects
(module crack detection) at the same time. A click on the button opens a dialogue which offers
individual or several selectable crack definitions. The crack objects are later activated with the
beginning of the measuring position and deactivated with its end.
Env. Offset:

Currently this is stil a developer feature. A time is assigned to crack objects which delays their
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activation. This only concerns object with enveloping surface.

In the process landscape the data in the area of an activated measuring position is displayed in
green. This setting can be switched off by a service technician.
The active measuring positions can be read in the process topology info box.
Note: If measuring positions are
applied you should still pay regard to
a sensible pre-amplification setting in
the port settings for the measuring
start. In the most favourable case this
is the pre-amplification that was set
by the measuring position which was
likely the first one to be activated.
Attention! The measuring is always started off with the pre-amplification from the port
settings. If the measuring position is activated simultaneously its pre-amplification
settings are not set until shortly after. This can cause a fluctuation of the preamplification at the measuring start.

5.6 Trigger Setting
The trigger-settings-dialogue includes:
• The I/O Ports configuration – the interface to a PLC control.
• The configuration of the Trigger list
• A test bed to validate the I/O In- and Output
I/O ports are the 32 in- and outputs, at the front of the Optimizer4D system, the interface that
communicates with external machines – their PLC respectively.
This interface works with a 24V DC voltage signal level, from the output as well as from the input.
Note: The inputs and the outputs of the interface are galvanically separated from the
system. You can find more information about this and the pin allocation in the technical
manual.

A trigger describes events which activate a certain program controlling action.
This may be signals from the I/O ports or key entries, time controlled events, results of the
automation and so on (more about this in “Tab Trigger settings”)
Open this dialogue with MenuConfigurationTrigger Settings
Attention! In an open trigger dialogue the trigger list is not going to be
processed! Die Busy I/O port is set and signals from the machine are ignored
while the triggers are being processed.

5.6.1 I/O Lines
This tab offers a test bed that monitors or switches the signal at the I/O lines – depending on
the function of the signal line.
The flashing display on the top right of I/O signalüberwachung signals that a connection to the
interface is established which is being scanned constantly.
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Illustration 5.68: Trigger settings - I/O Lines – Testing window

Please note:
If the display is not flashing green that indicates that the Kernel
module has not booted. In this case the system should be rebooted.

5.6.1.1 Input signals
Here you can read the current input status of every single
input. If a signal reached the input the corresponding light
is green.
Note: The signal lines come with LEDs right below the jack sockets for the connection
to the Optimizer4D system. These light start to flash once a signal (+24V lever) is
coming in.

Illustration 5.69: I/O interface with LEDs

5.6.1.2 Output signals
Here you can find the switches to either
activate or deactivate the individual outputs of
the I/O signal lines. The number of the outputs
depends on the setting “I/O block 4 is input” in
the
menu Illustration 5.70: Control ouput signals
ConfigurationPreferencesSystem, as the upper eight connections of the I/O signal
lines can optionally be used as out- or input.
Note: The signal lines are equipped with green LEDs below the jack sockets for the
connection to the Optimizer4D that will flash as soon as a signal is delivered.
Attention! To control the output signals the external +24V voltage at pin 1 (VCC) of the
respective I/O port has to be established. Furthermore it is advisable to establish a
ground connection between the GND of the input block in use and the GND of the output
block.

5.6.2 Trigger list
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A trigger is an event that is followed by an action in the program – it could be an event that is
caused by the I/O signal lines a, by Profibus messages or even by processes in the program
itself.
In the tabulator Trigger list you can configure which triggers are active and the attached
actions that are going to be caused by them.
The trigger list and the trigger system can be seen as kind of a Mini-PLC application for the
Analyzer4D. The trigger list is being worked through every 2ms.
Note: The frequency of the trigger processing can be changed to other values than 2ms
by one of our service technicians.
Attention! To enable the triggers activate the trigger symbol in the menu “Measuring
activate trigger”. If this is not the case the application will not react to external signals from
the I/O lines or other events.

Illustration 5.71: Dialogue "Trigger settings" – Trigger definitions

5.6.2.1 Add Trigger
This is how you define a trigger and add it to the trigger list:
1. Choose the desired trigger type in the check box select trigger type in the add new
trigger group.
• (You can look up details about the different types of triggers in “Trigger settings – Trigger types”)
2. Click Add trigger . The trigger is now attached to the trigger list.
3. If the trigger type requires it, do a parametrization in the columns Trg attribute and
Attributes .
4. Now choose the desired action, i.e. the command, that shall be executed while the
trigger is active. Thereto you use the check box in the column Command to execute in
the line of the trigger that you inserted before.
•

(Look for details about the different commands under “Trigger settings – Trigger commands)

5. If the command requires it execute a parametrization in the column Command Para .
6. If you desire a delay of the execution after the receipt of the trigger signal enter the
favoured fair value (always in ms) into the column Delay .
7. Click Apply to use the latest trigger list. You should save the project after closing the
trigger-setting-dialogue.
5.6.2.2 Trigger list
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The different triggers appear in a list after having been added.

Illustration 5.72: Trigger list

•
•
•
•
•

•
•

The column No shows the assigned trigger number
The column trigger type shows the trigger type
In the column Trg para you can find configurable parameters for the trigger, which can have
a different function depending on the trigger type
In the column Trg attribute you set additional parameters for particular triggers
In the very important column Command to execute you can see which action is being caused
by the trigger in the end and which configurable parameter is required for this action (if the
command requires additional parameters)
If needed you can define more parameters for trigger commands in the column Attribute
The column Delay defines the fair value by which the execution of the trigger command is
delayed in milliseconds

5.6.2.3 Delete Triggers
If you want to delete one or more lines of triggers go to the No -column and click the button
with the trigger number in the same line as the trigger which is to be deleted.
Afterwards you click delete selected trigger or press the Del-key if you have connected a
keyboard.
You will get a confirmation prompt. If you click OK the trigger lines whose No-buttons have
been selected will be deleted.
Note: To apply the changes you have to select Apply or Apply & Close. The project should
also be saved, otherwise the old trigger settings are going to be restored with the next loading
process.
Tip: Triggers can also be deleted by dragging and dropping the trigger type on the
selected Trigger button.

delete

5.6.2.4 activate / deactivate triggers
Trigger lines can be overridden. Depending on the method of deleting triggers you can select
one or more triggers and then you click button (De)activate selected Trigger .
5.6.2.5 Duplicate Triggers
Depending on the method of deleting triggers, choose on ore more consecutive trigger lines
and click Clone selected Trigger . The selected trigger lines are created as a copie below the
trigger that has been selected last. The trigger commands are not copied in this process.
5.6.2.6 Move Trigger
Every trigger line can be moved around in the trigger list. That makes it possible to arrange
the triggers either in an overseeable or in a manner that corresponds logically with the
procedure.
Drag the trigger line by clicking and holding the trigger type button to the new position in the
list.
You can also move a whole block by selecting the trigger column with a click on the trigger
column number. Then you press the cursor-keys “up” or “down” to move the selected trigger
columns.
5.6.3 Trigger settings – Trigger types
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In the Analyser4D-Program you can define various triggers which react to different sources of
events. In the following you will receive a listing of all trigger types with all their additional
configuration parameters.
5.6.3.1 I/O INPUT LINE
The I/O Input Line Trigger reacts to signals which are waiting at the I/O interface of the
Optimizer4D System.
An I/O Input Line Trigger stringently needs to know the number of the input line as well as
the method with which it should react to this particular signal (Trg attribute) for a parameter
(Trg para).
Attention! The input line number is not equivalent to the Pin-number of the connector
blocks. E.g. input line “1” lies on pin 2 of the left connector block

An I/O Input Line Trigger has the following setting options in the line Trg attribute:
• rising edge : Trigger reacts when the signal edge is rising
• falling edge : Trigger reacts when the signal edge is falling
Usually the setting will be “rising edge” if the PLC of the machine puts a signal line of the I/O
interface on high to signal about something.
See “Trigger command” for the available commands of the “I/O Input Line Triggers”

5.6.3.2 KEY STROKE EVENT (Keyboard Trigger)
A Key Stroke Event Trigger reacts to the key press of a connected PC-keyboard. For this the
main window of the Analyzer4D Application has to have the input focus. The key to which
the trigger reacts is entered by using the virtual keyboard in the Trg para. Or you click the
input field and then press the desired key.
See “Trigger command” for the available commands of the “Key Stroke Event
Triggers”

5.6.3.3 PROCESS TIMEOUT
The Process time out Trigger does not need any input parameters. It is triggered when the
reference period of the process is expired or transcended. The reference period of the process
is set automatically set in the project after finishing the first measurement process.
However, in the Trg para field you can also enter a number. Following beginning the
measurement process this number acts as a time interval of seconds after which the trigger
sets off.
Typically this trigger is used to realise a “safety measurement shutdown” if the time that the
process is taking is abnormally long.
This trigger has a complete set of commandos at its disposal.
But usually the setting is Stop measuring.
See “Trigger command” for the available commands of the “Timeout Trigger”

5.6.3.4 ENERGY OBSERVER (Energy threshold trigger)
Attention! This trigger solely makes sense in context with monitoring, however, that is
not available with the current Analyzer4D version.

This trigger only operates during the surveillance of the measuring process in the monitor
mode. The trigger reacts to the transgression of a certain energy threshold. The amount of the
energy level is entered into the Trg para field. The trigger can be used to start a measurement
as soon as a high energy level occurs.
The trigger needs the window that is defined to set the frequency range and the extent of time.
(See also MenuAnalyzeEnergy calculation)
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5.6.3.5 I/O SELFTEST REQUEST
This trigger reacts when the self test command was recognised at the I/O-interface. The I/O
input 1.6 is the one that is used for the self test.
Attention, this trigger can cause functions to overlap when used simultaneously. This is
due to the fact that there might be prompted the same I/O lines

5.6.3.6 I/O NEXT WORKPIECE (requesting a new work piece via I/O ID)
This trigger is a specified version of the “I/O input line” trigger and it prompts input 1.6 when
a rising edge appears. The trigger type improves the readability of the trigger list and mainly
helps to better the compatibility with the signal names of the Cis01 Measuring system. →
“NEXT WORKPIECE (NEXT WP)”

Attention, this trigger can cause functions to overlap when used simultaneously. This is
due to the fact that there might be prompted the same I/O lines

5.6.3.7 I/O MEASURE ON (normal) (requesting start of measurement)
This trigger reacts to the signal “start analogue measurement” at the I/O-interface.
If a rising edge registers at one of the inputs 1.1 – 1.5 the trigger reacts.
The input at which the event was recognised is stored internally and can be passed on to the
trigger command (so called pipe, provided the support from the trigger command). E.g. you
can actuate measure positions with this technique.
Attention, this trigger can cause functions to overlap when used simultaneously. This is
due to the fact that there might be prompted the same I/O lines

5.6.3.8 I/O MEASURE ON (binary) (requesting start of measurement)
This trigger reacts to the signal “star binary measurement” at the I/O-interface.
If a rising edge (strobe) registers at the I/O input the trigger reacts..
At the same time the bit combination that comes in at the inputs 1.1 – 1.4 is decoded as a
binary number and stored internally as a submission number. (thus resulting in a value range
of 0-15). This submission number can be passed on to the corresponding trigger command (so
called pipe provided the support from the trigger command). With this technique yo can
actuate as much as up to 16 measure positions.
5.6.3.9 I/O LOAD PROJECT (requesting changing the work piece set)
This trigger reacts to the signal “change work piece set” at the I/O-interface.
Here “change work piece set” also means changing projects.
This trigger contains a hidden parameter. It can be passed on to the command to be executed
(keyword: pipe). This parameter is the “Project ID” that results from the successive signal
inputs at the I/O-interface. E.g. the value can be passed on directly to the command “Load
project with I/O ID” (see project I/O-ID).
Attention, this trigger can cause functions to overlap when used simultaneously. This is
due to the fact that there might be prompted the same I/O lines

5.6.3.10 AUTOMATION STATUS (result of the automation)
This trigger reacts to the signal that is sent at the end of a measuring process by the
automation tools (crack detection, pattern recognition…). It serves accepting the result of the
process and therefore react to an OK- or Not OK-component..
The trigger differentiates between two conditions, which can be configured in the Trg para
field.
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failed NOK: trigger reacts to a faulty process operation (NOK)
passed OK: trigger reacts to a process operating within the tolerance threshold (OK)
Usually this trigger activates or deactivates I/O input signals to send a status update back to
the machine under monitoring.
5.6.3.11 OBJECT FAILED (object recognition error)
This trigger reacts to a certain signal of the pattern recognition which is sent if there is an
object that is either not being recognised or whose parameters are outside of the tolerance
range during an ongoing measurement.
It is suitable for a prompt reaction to events in the process.
You have to enter the measuring channel to which the trigger should listen into the Trg para
field.
Note: Perhaps the pattern recognition ist not activated or available for the program
version on hand.

5.6.3.12 CRACK EVENT
This trigger reacts to every signal of a crack-event that is sent by the crack detection module.
The trigger parameters and attributes help to specify respectively filter the crack-event:
Trg para:
Specifies the kind of crack-event which ought to be triggered
• Microcrack
• Crack
• Break
• All types (microcrack or crack or break)
Trg attribute:
Enables the choice of a certain crack object as source of the signal.
Here the ID matches the line number in the crack definition list of the crack detection
dialogue.
“All Objects” selects all existing crack definitions as a possible source of the crack-event.
5.6.3.13 CRACK DEFINITION WARNING (crack object has exceeded its warning
level)
This trigger reacts when the crack detection module notices a transgression of the thresholds
and warning levels in a crack definition object. This usually happens when a certain number
of micro cracks appears or has been exceeded.
You have to enter the object number (ID) to which the trigger should react into the Trg para
field.
Note: “Every ID” means that the object number is being ignored and the trigger will
react to any signal

You can enter the crack type into the Trg attribute field.
Note: A “Crack Definition Warning” can only be triggered once in a measuring process
for every crack type and crack definition. Although, it can happen that a small crack
develops into a break. When this happens you will respectively get a crack warning for
the types microcrack, crack and break in sequence.

5.6.3.14 ENUMERATOR TARGET (enumerator target value reached)
The Analyzer4D program has 10 numerators to its service that can be used as a sum memory
(enumerators). These numerators only allow positive digits.
The trigger reacts as soon as the defaulted counter reading is reached or exceeded.
With the Trg para you can set which numerator is to be monitored (1-10)
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The Trg attribute sets the target value. If this target value is either reached or exceeded the
trigger reacts once.
5.6.3.15 MEASURE STATUS CHANGED
The trigger reacts after the situation of the measuring has changed.
Configurable by using the trigger parameter:
• Started: Measuring has been started
• Stopped: Measuring has been stopped
• New Polycyclic started: A ne polycyclic process has been started
The trigger has the process number ready internally. The number will be passed on to the
trigger command if it does not support “pipe”.
5.6.3.16 TIMER TARGET (measure one shot) (timer target value reached)
The Analyzer4D program has 5 time keepers at its service with which time controlled
procedures concerning the trigger management can be realised.
The trigger reacts when the runtime of the configured timer has reached the defaulted value.
The timer begins with the start of the measuring.
The target time value for the trigger parameter is to be entered in ms. Also allowed is
information like: 3s → 3000ms → 3000
Attention! A timer cannot be used more than once. There can only be one trigger line
that addresses one particular timer of the 5.

5.6.3.17 TIMER TARGET (measure multi) (timer target value multiple)
Unlike with the TIMER TARGET (one shot) you can set 2 target time values with the TIMER
TARGET (multi). The first time the trigger will react when a target time 1 is reached and then
again and again after the lapse of time of target time 2.
E.g. the trigger parameter: “5s; 10s” results in a trigger after 5 seconds and then every 10
seconds after.
The timer starts at the beginning of the measuring
Attention! A timer cannot be used more than once. There can only be one trigger line
that addresses one particular timer of the 5.

5.6.3.18

TIMER TARGET (manually)

This trigger is a developer feature which is not recommended to be used at the moment.

This timer works like TIMER TARGET (measure one shot) only that it is reset at the begin of
the measuring. The timers of triggers of that kind are reset with the start-up. They can only be
influenced by the timer-control trigger-command.
5.6.3.19 PATTERN MATCH (pattern has been recognised)
This trigger reacts when the pattern recognition reports a an identified reference object.
Here you can set an ID as parameter. This would be an ID of the reference object group
which contains the pattern that you are searching for. (see also pattern recognition
configuration dialogue)
5.6.3.20

PATTERN CHANGED (recognised pattern changes its coverage value)

This trigger is a developer feature

This trigger reacts when the coverage value (Similarity) of a reference object that has already
been recognised will be even better later on. This behaviour can occur if the detailed analysis
of the pattern recognition starts analysing in a very eager manner after the object has already
been identified.
5.6.3.21

STATE (status trigger)
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Attention! This trigger is a feature for service technicians or developers

This trigger does not just react once when an event occurs, but every time the result of the
condition in the trigger parameter ist true.
Generally the STATE trigger is used in conjuntion with the JUMP TO command which allows
to skip lines in the trigger list.
The following conditions can be evaluated:
• Measure State: the current measuring state correspond with the one in Attribute (0:
IDLE; 1: Measuring is running; 8: FAILSTATE; 10: Paused)
• Time since measuring start exceeds the time value in Attribute (ms)
• Time since measuring start falls below the time value in Attribute (ms)
• Time since measuring stop exceeds the time value in Attribute (ms)
• Time since measuring stop falls below the time value in Attribute (ms)
• Counter reading of an enumerator exceeds the value in Attribute
• Counter reading of an enumerator falls below the value in Attribute
• The time since the last change of the counter reading exceeds the value in Attribute
• The time since the last change of the counter reading falls below the value in Attribute
The attribute format for the conditions specific for the Enumerator is:
<NumeratorNumber>;<Timevalue><TimeUnit>
Of course it does not make sense to use for instance “Start Measuring” as a trigger
command because it would cause the program to try starting a measuring every 2ms.

5.6.3.22 INSTANT CRACK EVENT
This trigger behaves exactly like the CRACK DEFINITION WARNING trigger.
But in contrast this one will report the event much sooner.
Normally the warning is generated when the signal of the crack (or generally of the energetic
event) has subsided. With INSTANT CRACK EVENT the warning will be sent as soon as the
defaulted energy- and warning threshold is first exceeded.
The benefit is that perhaps the machine can react early on to prevent any damaging of the
tool.
However, a break may initially be reported as a crack when the energy is rising slowly.
Note: Breaks will also be reported immediately when using CRACK DEFINITION
WARNING trigger

5.6.3.23

I/O State (input status)

Attention! This trigger is a feature for service technicians or developers

This trigger queries the current status of the I/O inputs.
The trigger does not react just once when an event occurs, but every time when the input
status matches the parametrized settings.
Generally the STATE trigger is used in conjunction with the JUMP TO command which
allows to skip lines in the trigger list.
5.6.4 Modbus Trigger
Note: Modbus functions may not be available depending on the installed Analyzer4D
program version

Modbus triggers serve the communication with device that support the Modbus Master/Slave
communication log.
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The Optimizer can be integrated into a Modbus system and appear al a client.
Modbus communications in the Analyzer4D is individually fitted the respective application
by QASS and is usually configured by one of our service technicians.
Current Modbus triggers are:
• Measure request:
Modbus requests measuring start
• Measure stop request:Modbus requests measuring stop
• Self test request:
Modbus requests Optimizer4D self test
• System shutdown:
Modbus requests shut-off of the Optimizer4D system
• Serial received:
Modbus has sent serial number
• Custom bit changed: A freely definable byte changed in the Modbus message
• Activation frame activated: Modbus requests activating a measure position or a crack
object
• Polycyclic mode changed: Modbus changed the polycyclic mode
The communication between the Modbus Master (machine) and the Modbus Slave
(Optimizer) is executed with message telegrams through the serial connection.
Note: The configuration of these telegrams takes place in the Modbus Settings: ( Menu
→ Configuration → Modbus-Settings)

5.6.5 Trigger list – Trigger commands
To ensure that a trigger can function satisfactorily it has to be assigned with a command
which is executed in the exact moment the trigger reacts. These commands are listed in the
executive field in the respective trigger line.
The commands can be configured in the settings in “command para” and “command
attribute”.
If a new trigger is added to the list or an entry is cloned the default-trigger command will
appear automatically in the column execute command for the respective trigger type or it
may also be the command “Do nothing”. By clicking the command-button a dialogue will
open. Here you can choose a different trigger command.
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For a better overview the trigger commands are subdivided into functional groups. One click
on the desired button selects the trigger command and the dialogue will close. Now the
parameters and attributes have to be configured in the trigger-list-window.
In the following you can find a list of all commands, sorted by functional groups and with
comments on the parameters.
6
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5.6.6 Trigger Command Group “Measuring”
5.6.6.1 Do Nothing (Dummy function)
This commando does nothing at all and it is suited to deactivate a trigger for a short amount
of time..
Note: Trigger lines can also be deactivated with “Enable / Disable selected Triggers”

5.6.6.2 Start Measuring
Starts the measuring or the process monitoring with the currently configured parameters.
At that a new process number is produced automatically.
5.6.6.3 Stop Measuring
Stops the measuring or the process monitoring. Simultaneously all work is done to store the
new process with all its statistical data. If the automation was active (crack detection module
or pattern recognition module) the conclusive evaluations are conducted and the
corresponding result signals are sent.
5.6.6.4 Next work piece (NEXT WP)
Induces the following actions:
• Running measuring process is ended
• Self test and sensor test are started with the parameters that were set for the current
project in the sensor calibration dialogue. If an error occurs during this process the
device will switch to the FAILSTATE mode and the I/O Ready Output will be reset.
• The running process number will be increased. (In some circumstances this creates
“empty” processes without data if the “Next work piece” command appears several
times in a row)
“Next work piece” does not have to and cannot be parametrized any further.
Note: This command is part of the Cis01 compatibility settings

5.6.6.5 Switch to measure position (switch measure position on- / off)
Activates or deactivates one of 16 measure positions.
A measure position is a set of configuration settings which allows you to switch parameters
like pre-amplifying, sensor port and activated crack definitions during the measuring. The
measure positions are set up or configured in the dialogue Multiplexer.
The parameter determines which measure position shall be activated:
• Position #x : Explicit statement of a measure position from 1 to 16
• Enum #x : The counter reading of an enumerator which is interpreted as a measure
position number
• Forward : (Pipe). The measure position results from the numeric value that the trigger
type sent as soon as the trigger event started. (e.g. MEASURE ON)
• Deactivate : The current measure position is ended (with this mainly the
corresponding crack definitions are deactivated)
Note: SWITCH TO MEASURE POSITION can always only activate one individual measure
position. If it is required that the measure position is specific for the channels (one active
measure position per channel) ACTIVATE MEASURE POSITION and DEACTIVATE
MEASURE POSITION are relevant

The attribute determines if activating the measure position also has to result in starting a
measuring.
• Smart Start: The measuring starts if it is inactive at the moment a trigger happens.
• Do nothing: Solely the measure position parameters are set.
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5.6.6.6 Activate Measure Position (for channel)
Activates one of 16 measure positions for a certain measure channel.
(see also Switch to measure position).
A measure position can store certain pre-amplifier- and crack object settings and employ
those on the measure channel.
The parameter determines the channel for which the measure position will be activated.
The attribute determines which measure position shall be activated:
• Pos #x : Explicit statement of a measure position from 1 to 16
• Enum #x : The counter reading of an enumerator which is interpreted as a measure
position number
• Forward: (Pipe).The measure position results from the numeric value that the trigger
type sent as soon as the trigger event started. (e.g. MEASURE ON)
5.6.6.7 Deactivate Measure Position (for channel)
Deactivates the measure position for a certain measure channel.
(see also Switch to measure position).
The parameter determines the channel for which the measure position is to be activated.
5.6.6.8 Activate pattern group (Activate pattern reference object group)
Note: The command may be functionless depending on the software version

Activates the search for all reference objects that are located in a certain group, in the selected
measure channel.
The parameter determines the channel which is going to be searched for the patterns
The attribute determines which reference object group/s is/are to be activated:
• Pos #x : Explicit statement of the group ID from 1 to 16
• Enum #x : The counter value of an enumerator which is interpreted as group ID
• Forward : (Pipe). The group ID results from the numeric value that the trigger type
sent as soon as the trigger event started. (e.g. MEASURE ON)
The group ID has to be assigned to the pattern recognition configuration dialogue of the
group and the group must not be activated permanently, otherwise the trigger command
will not have an impact.

5.6.6.9 Deactivate pattern group (reference object group)
Note: The command might be functionless depending on the software version

Deactivates search for the reference objects, which are located in the selected group, for the
selected measuring channel.
The parameter determines the measuring channel on which the pattern recognition is
deactivated
The attribute determines which reference objects group(s) shall be deactivated:
• Pos #x : Explicit statement of the group ID from 1 to 16
• Enum #x : The counter value of the enumerator which is interpreted as group ID
• Forward : (Pipe). The group ID results from the numeric value that the trigger type
sent as soon as the trigger event started. (e.g. MEASURE ON)
5.6.6.10 Activate definition object (activate crack definition / crack object)
Activates a certain crack object or all of them in the crack detection module.
This command for instance enables a machine controlled search for crack events and/or to
switch on the energy monitoring.
The parameter determined which crack definitions (crack objects) are being activated
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• ID #x : Explicit statement of the crack object ID from 1 to 16
• ID #Enum_x : The counter value of an enumerator is interpreted as crack object ID
• Activate all : All crack objects are being switched on.
The crack object ID can be read in the configuration dialogue for crack detection. The ID is
the column number of the crack object (crack definition ID)
Note: For correct functionality the desired crack objects have to be parametrised as
“externally triggered” in the crack object configuration.
Note: If you named the crack objects these will additionally be displayed in the
parameter selection.

5.6.6.11

Switch Channel X To Preamp

This command is not available in the new Analyzer4D versions any more. Die
functionality can instead be recreated with measuring positions in a more flexible manner.

Switches the channel specified in the command name to a different preamp port. The desired
preamplifier is entered into the Command para field.
Attention! This trigger command changes the Multiplexer configuration. Please be sure to
always use the same basic settings when starting the measuring.

Example:
We start a measuring on channel 1 which is connected with the pre-amplifier 1 (port 1).
During the measuring the switch channel 1 to preamp command with set command para “3”
is going to be induced by a trigger. Now channel 1 will be disconnected from port 1 in the
Multiplexer and instead get connected to port 3. Therefore the further measuring with the
sensor will be conducted on preamp 3.
Note: The switched to pre-amplifier should be activated in the Multiplexer setting
before the measuring!

5.6.6.12 Pause measuring
A running measuring can be stopped to spare hard drive space by skipping non-relevant areas
of the process.
A paused measuring is displayed as a flashing message box in the graphics window.
The pause trigger command support these parameters:
• Resume: The pause mode is ended (in case the measuring is not even running, a new
measuring will not begin)
• Pause: A running measuring is being paused and set into a waiting mode
• Forward: A “low level”=0 from trigger pauses the measuring, all other values exits the
pause.
Note: If the Optimizer is in pause mode no new measuring can begin. First, the
running measuring has to be ended (by trigger command or manually)

5.6.7 Trigger Command Group “I/O”
5.6.7.1 Reset all custom lines
Sets back all I/O outputs 3.4 – 3.8 (to low).
If the I/O block 4 is configured as an output in the system, the I/O outputs 4.1– 4.8 are also
reset.
I/Os 3.1 – 3.3 are already preallocated by the system as READY, BUSY and MEASURE
MONITOR and are not being affected by the trigger command.
5.6.7.2 I/O Set line (Set output)
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This command sets an I/O output signal line on active (high).
Here the command parameter field contains the respective output line number.
Possible outputs are output 3.4 – 3.8 as well as output 4.1 – 4.8 (If I/O block 4 is set as output
in the system)
5.6.7.3 I/O Clear Line (turn off I/O output)
This command set an I/O output signal line on inactive (low).
Here the command parameter field contains the respective output line number.
Possible outputs are output 3.4 – 3.8 as well as 4.1 – 4.8 (if I/O block 4 is set as output in the
system)
5.6.7.4 I/O Toggle Line (switch I/O original state)
This command inverts the state of an I/O output signal line.
Here hhe command parameter field contains the respective output line number.
Possible outputs are output 3.4 – 3.8 as well as 4.1 – 4.8 (if I/O block 4 is set as output in the
system)
5.6.7.5 I/O Switch busy line (switch BUSY output)
This command switches the dedicated busy output to active or inactive at the I/O interface
(normally output 3.2) depending on the setting in the command parameter field
Note: Level 0 correspond to “low” or inactive

5.6.7.6 I/O Set output event
This command allow for an event number to be sent to the I/O interface which can be
prompted again at the output lines by the PLC.
Thereby the number is binary-coded on a series of consecutive output lines. Afterwards a
strobe signal is sent on a specific output line that lasts for about 1s and tells the PLC that a
valid event number is currently abut.
The number is listed in the command parameter field
Strobe is laid on on output 4.8
The event number is laid on 4.1 – 4.7

5.6.7.7 Load project with I/O ID
This command loads a project based on an allocated I/O-ID.
Each prjects can get a distinct I/O-ID that allows the Analyzer4D program (thus a tool
parameter replacement) to load by identification using this Id.
The advantage is that the I/O-ID can be displayed binary at the input signal lines of the I/O
interface.
The Load project with I/O ID command can be used in combination with the I/O LOAD
WORKPIECE SET trigger. Here the trigger passes on the I/O-ID directly to the command.
The command parameter has to be clear at this and the command attribute has to be set on
“pipe”
If the command parameter field contains a value that is not “0” and the command attribute
is “Edit” the value is interpreted as I/O-ID and tries to load the respective project.
Attention! If the I/O-ID is not familiar, thus not assigned to any project, no error
message that has to be acknowledged by the user will occur.
Note: Instead of an error message caused by a non-existing I/O ID a service technician
can configure the application to create a new project with default settings and the
requested ID.

5.6.7.8 Evaluate Crack Acknowledge
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Allows the evaluation of an acknowledge signal from the controlling machine.
This serves the verification of the events that you reported to the machine and helps to
improve the safety of the process.
If the machine does not reply in a defined time period the Analyzer4D program initiates a
system fail status that can only be reset on the screen.
The parameter configures the input that awaits the response signal of the PLC.
In Attributes you set if:
• Immediate error: only a short waiting time of 100ms goes by before the bug status is
triggered
• Error after measuring stop: the response signal is evaluated after measuring stop
E.g. in the field the procedure goes as follows:
1. The Optimizer recognises for instance a component tolerance violation.
2. The Optimizer messages to output 3.4
3. The Optimizer waits for a confirmation to input 1.7
4. The machine control recognises the Optimizer output and reacts to it
5. The machine control reports it at the Optimizer input 1.7
6. The Optimizer stops the measuring.
• if input 1.7 is active the confirmation signal was OK and the normal process is
resumed
• if input 1.7 is inactive the Optimizers assumes a disrupted communication and
switches into FAILSTATE mode. As a result the READY output also becomes
inactive.
The respective trigger lines (without other controlling procedures) look like this:

Illustration 5.73: Trigger Crack Acknowledge Example

Note: This command is part of the Cis01 compatibility settings

5.6.8 Trigger Command Group “Controlling”
5.6.8.1 Set Comment
Adds a comment to the current process.
The commentary text is to be defined in the field command parameter. How the text is
imported into the comment field of the process depends on the setting of the attribute
• Pipe: The text is accepted by the trigger type, the content of the parameter field is
ignored
• Edit: The text is imported into the comment exactly as it appears under parameters.
• Template: The text in the parameter is sent through the template parser, which is able
to replace stubs by different parameters of the program, to then be imported into the
comment of the process.
• Enum #X: The counter reading of the respective enumerator is imported.
Note: The individual control characters that can always be introduces with a “%”
character can supportively be shown with a click on the button “Show template help”
in the trigger list dialogue.
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Illustration 5.74: "Set comment" Example: Here the text "Failed at count " + counter reading of enumerator 2 is set as a comment

5.6.8.2 Set pending comment
For this trigger command, the same applies as for “Set comment” only that the comment is
not being put in this process but in the process of the next measuring to be started.
5.6.8.3 Set serial number
Inserts a text into the serial number text box of the current process.
The serial number is stored separately from the process comment and can also be evaluated
separately. As with the “Set Comment” command, here you set in the attributes how the
serial number text is extracted.
• Pipe: The serial number is accepted by the trigger type, the content of the parameter
field is ignored
• Edit: The serial number is imported into the serial number field of the process exactly
as it appears under “parameter”.
• Template: The text in the parameter is sent through the template parser, which is able
to replace stubs by different parameters of the program, to then be imported into the
serial number of the process.
• Enum #X: The counter reading of the respective enumerator is imported.
Note: The individual control characters that can always be introduces with a “%”
character can supportively be shown with a click on the button “Show template help”
in the trigger list dialogue.

5.6.8.4 Set pending serial number
For this trigger command the same applies as for “Set serial number” only that the text is not
being put in this process but in the process of the next measuring to be started.
5.6.8.5 Set sub process number
Assigns a sub process number to the current process.
Sub processes allow you to summarise process sequences. With very long processes it makes
sense to cut them into a number of sub processes for instance. With the sub process numbers
you can manage this kind of measuring.
The attribute determines how the text under command parameter is being converted into
the sub process number.
Note: the resulting text has to be a decimal digit. In case the text contains other
characters for digits the sub process number will be set 0.

•
•
•
•

Pipe:
The number is calculated using the parameter sent by the trigger
Edit:
The number is copied par for par from the text box
Template:
The text box is directed through the parser and the resulting text is
imported as the number
Enum X:
The number is the counter reading of the respective enumerator

5.6.8.6 Set pending sub process number
Just like “Set sub process number” but the sup process number is being reserved for the next
process to be started.
5.6.8.7 JUMP TO LINE
This trigger command enables you to jump individual lines or function block while working
through the trigger list.
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The parameter sets in which trigger line the processing shall be resumed. Here only forward
jumps are possible.
The JUMP TO LINE trigger command is usually applied sensibly in connection with STATE
triggers.
Example:

Illustration 5.75: Trigger example: I/O State and JUMP TO LINE

Here the measuring is only being started if a rising edge is detected at port 1.1 and at the same
time port 1.2 is inactive; because if port 1.2 has high level the trigger line 2 is skipped.
That way, you can only partially configure AND links in the trigger list.
ATTENTION! If commands are deleted from or added to the trigger list, the jump
destination line can change. The JUMP TO LINE parameter is not adjusted automatically.

5.6.8.8 Increase Enumerator
This trigger command allows you to manipulated one of the 10 enumerators.
With the commando parameter you choose which enumerator shall be addressed.
The command attribute contains the value by which the selected enumerator will be
increased.
Example:

Illustration: Trigger example: enumerator and ENUMERATOR TARGET

Here the measuring is started (line 2) once a rising edge has been detected times at port 1.1
(line 1). At the same time the enumerator number 1 is set 0 so that the counting can start over.
Note: Negative attribute numbers lower the enumerator.

5.6.8.9 Reset Enumerator
This trigger command enables you to manipulate one of the 10 enumerators.
With the command parameter you choose which enumerator shall be addressed.
The command attribute contains the value that selected enumerator shall be set to.
5.6.8.10 Set polycyclic mode
This trigger command converts the current project to a polycyclic project.
In a polycyclic project processes can be split into sub processes.
At that the sequences of an individual measuring are being summarised as a unit.
This happens by assigning a so-called polycyclic ID to each measuring that is part of the
sequence. The individual measuring is still labelled “process” in the Analyzer4D application
but the additionally receive a sub process number.
The multiprocess ID is always the process number with which a new polycyclic sequence
begins.
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Reasons to use a the polycyclic mode in a project:
• A lengthy measuring time. The data can be managed in a more overseeable manner
• Long-term tests where e.g. a stress test is done several times for one component
Note: When switched to the polycyclic mode while it is not yet active, a new sequence
that begins with the sub process number 1 is automatically started.

5.6.8.11 Set pending polycyclic mode
Activates the polycyclic mode at the start of the following measuring. The current measuring
or the current process are affected by that.
Otherwise applies what is written under Set polycyclic mode.
5.6.8.12 Load project with name
This command is applied to load a project (work piece parameter set) using its project name.
The command attributes decides how the project name is determined.
• Pipe:
The trigger receives the project name through the parameter pipeline
• Edit:
The project name is imported, like stated in parameter
• Template:
The content of the parameter field is sent through the template parser
and the result is interpreted as a project name.
• Enum X:
The project name results from the counter reading of an enumerator.
Note: In case the resulting project name does not exist a system error message is
triggered and the READY output of the device is reset.
Tip: The service technician can configure the system so that a non-existing project is
automatically generated with the standard settings in case a project with a “load project
with name” trigger command does not exist.

5.6.8.13 Timer start
“Timer start” resets the elapsed time of the selected trigger to 0ms.
Simultaneously the timer is started, if it is not already active.
5.6.8.14 Timer stop
“Timer stop” stops the selected timer.
Therefore the timer cannot cause any more “Timer Target” trigger events.
5.6.9 Trigger Command Group “Display”
5.6.9.1 System fail message
The “System fail message” command is suited to generate an error message on the display
that has to be manually confirmed by the operator, if required.
At the same time an I/O output can be set or reset or the system can be set to a general system
fail status.
The I/O state, respectively the system system fail status, is lifted when the message on the
display is confirmed by the operator.
The Command parameter contains the text that is intended to be printed as a message.
This text is examined by the template parser and potentially contained stubs are replaced by
their respective equivalent.

Illustration 5.76: Trigger example: System fail message
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1.1.8.3 Display Score
This command can only be used sensibly in connection with the trigger automation result.
In the working set a graphic “level indication” you choose which enumerator shall be
addressed.
The command attribute contains the value by which the selected enumerator will be
increased. which provides information about the quality of the automation results. The
display contains a score that is higher the worse the process operation was. So an ideal
process would have a score of “0”.
Note: The score is only being transmitted by the crack detection module! The score
level is depending on the number of crack events that occurred and the level of
measured energy of the cracks.

This command mainly serves the visual control of the one operating the manually working
machines.
5.6.9.2 Recall View holder
This command restores a display configuration in the process display of the active workspace,
which is stored in a view holder button. The function has an effect similar to what happens
when you activate the button with a mouse click.
A sensible application for this is e.g. zooming out to view the whole process landscape after
measuring stop (during the measuring the displayed time range is automatically set to one
second). To do so just set the favoured view in the workspace and save with by right-clicking
the desired view holder button.
The command parameter field defines which view holder button is going to be used.
5.6.9.3 Save Screenshot
This command saves a screenshot of the view in the workspace as soon as it is activated. The
screenshot is going to be stored as an image file in PNG format below the basic list of the
loaded project.
The screenshot only contains the graphic measuring data view of the application (the 3D area)
This function is often used in connection with “Recall View holder”. However, it has to be
insured that after the selection of the view really has been updated. The easiest way to
do so is to delay the “Save Screenshot” command by about 300ms (Delay in the trigger
list )
Attention! At the moment (Analyzer version V1.75.23) the screenshots are not deleted
from the target folder. Odds are that the hard drive will be filled up and no further
measuring is possible if the screenshot table is not emptied by external tools (e.g. via
network) or manually.

5.6.10

Trigger Command Group “Modbus”
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Note: Modbus functions may not be available depending on the installed Analyzer4D
program version

Modbus trigger commands serve the communication with devices that support the Modbus
master/slave communication protocol.
The Optimizer can be integrated in a Modbus system and appear as a client.
Modbus communication in the Analyzer4D is fitted individually to the respective application
by QASS and is usually configured by a service technician.
5.6.10.1

Modbus: Warning exceeded

Note: This trigger function is being fitted individually and is configured by the service
technician.

Report the system fail status via Modbus on channel 1 or 2.
5.6.10.2

Modbus: Poll sub process

Note: This trigger function is being fitted individually and is configured by the service
technician.

Get the sub process number from the Modbus master and, depending on the setting, setting it
a process number or pending process number.
5.6.11

Trigger Commando Group “System”

5.6.11.1 Perform selftest
When activating “Perform selftest” the Analyzer4D application initiates a selftest.
Here the system is being checked for functionality and several tests are conducted depending
on the configuration.
If a test fails of the pre-configured parameters are not adhered to the system will be set into
system fail state.
Note: The system fail state can be reset by manually confirming it on the user
interface or re-conducting the selftest (with positive outcome). Meanwhile the
application reacts to no other trigger commands.

An important part of the selftest is the sensor test. All sensors configured for the current
project and measurement inputs are examined according to the setting in the sensor
calibration dialogue (Menu → Configuration → Sensor calibration).
This process is called coupling test.
The self text should be activated regularly before and after a measuring.
Note: The selftest can last up to 5 seconds depending on the configuration of both
system and project. During this time the BUSY I/O output is set 1.2, the READY output
remains 1.1. Meanwhile the system does not accept any commands.

5.6.11.2

Perform cable test

Note: This command is a Cis01 compatibility function

The cable text for each configured pre-amplifier and sensor is performed in the sensor
calibration dialogue according to the configuration.
If an error is detected or the adjusted threshold values are not reached the system is set into
system fail state.
See also: “Perform selftest”!
The cable test can also be performed during a running measurement.
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During a cable test the capacity of the connected cables and sensors are in the tolerance
range. This procedure serves detecting severed cables and cable breaks.
Attention! A loose and therefore poorly connected sensor is not going to be detected by
the cable test.

5.6.11.3 Fire Default Pulse
This command triggers the pre-amplifier impulse test. The impulse parameters (strength and
port) are all extracted from the Multiplexer dialogue of the group impulse test. This is also
where the impulse can be triggered.
This feature is suited e.g. for resonance analysis. Like this you can couple pulses into the
component through the second sensor which is connected to the additional pre-amplifier.
These impulses will be evaluated by the primary measuring sensor.
Background: During the preamp impulse test a high voltage, produced by the pre-amplifier, is
abruptly discharged over the piezo-crystal. This is followed by a mechanical pressure wave
from the sensor.
5.6.11.4

Print process to serial

Note: This is a service technician or developer feature

This command sends a text to a printer that is connected to the serial interface (or a different
serial receiving station).
The text is configured in the parameter field of the trigger command and is processed by the
template parser.
The serial interface is set in the default dialogue in the tabulator “System” under Serial
printer device.
5.6.11.5

Crack detection auto teach

Note: This is a developer feature

5.6.11.6

Execute shell command

Note: This is a developer feature

This command allows you to perform any command in the operating system of the Optimizer.
The command is started a separate task and it is neither followed by a response to the
Analyzer4D application nor can it be cancelled by it. The output is written down in the log.
5.6.11.7 Shutdown system
This command stops the Analyzer4D application and shuts down the Optimizer4D system
completely.
Attention! The system is not available after the shutdown and has to be re-activated with
the main switch.

5.6.11.8

Execute FUNCTION

Note: This is a developer feature

Behind this command stand several developer features or special functions specifically
aligned to certain applications that can change any time.
The usage of these functions remain reserved for the service technicians.
5.6.11.9 Delete raw process data
This function enables you to delete the uncompressed raw data of a process.
The process number is adjusted over the command attribute:
• The process at the moment of the trigger event
• The current process number
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• The process number sent by the trigger
The command parameter sets:
• Channel X: Only raw data of the processes with channel number X are deleted
• Channels w/o warning: The raw data are deleted if the evaluation module has
generated a warning.
This command helps sparing storage space, e.g. when lengthy measurement series are
recorded but only individual processes with significant events are relevant for the evaluation.
A Measuring which components are OK are not stored, at most the compressed buffers for the
overview.
6
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5.7 User administration
The Analyzer4D offers a simple user administration; a user level is allocated to each user
when logging in. This level determines which program functions are available for the user.
The higher the level, the greater the range of functions.
5.7.1 User level
User level overview:
Level

Functions

0

- No rights

1

- Operator

3

- Trained operator

5

- Operator
- is allowed to create projects

8

- Administrator access
- Link functionality
- User management
- Beta test functions

9

- Service access
- maintenance and restoring functions

The standard user should obtain the level 5 to enable the unrestricted work with the
Optimizer.
In an automation environment a user level of 1-3 is advisable
5.7.2 1.1.2 Access and functions
Get to the user administration over the menu bar Configuration → user administration . You need a
user level login of at least 8 to see this menu item.

Illustration 5.77: Dialogue User administration
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In the list window you can see all users created until now, listing serial number, their name
and user level. The user with the Id #1 is created by default and cannot be changed or deleted.
5.7.2.1 1.1.2.1 Creating a new user
Click “New User”, add a new user with identification “new” and a level of 1 to the user list.
Adjust the user's data in the next step.
5.7.2.2 1.1.2.2 Changing access data
Click in the user identification field (“new” if it is a new user) to display a virtual keyboard.
Using this, you may type a new identification; confirm with “Enter”.
Similar procedure for a new password: Click on “Change Password” and enter a new
password.
ATTENTION! Please mind that the passwords are saved encrypted, you cannot make
them visible. If a user forgets his password, a new one has to be entered in the user
administration.

Lastly you can set the user level. Do this either over the input field (by keyboard) or
increase/lower the level step by step using the arrow fields.
If you as an administrator forget your access data, please contact QASS. We will provide you
with new access.
5.7.2.3 1.1.2.3 Deleting a user
Seek the user to be deleted in the list and click “Delete User” in the corresponding line.
Confirm the deleting. Click “OK” to execute. The user will be removed from the list and his
access data will be erased.
6
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5.8 Controls
5.8.1 Parameter Wheel
The parameter wheel helps to enter numeric values in a quick and comfortable manner especially when you are using a touch-screen if no keyboard is available.

You can "turn" the wheel via mouse or touch-screen.
The wheel acts like a fly wheel, it can be pushed,
oscillates and runs stagnant. The numeric value
changes corresponding to the turning velocity.
The blue "level" bar is the graphic equivalent to the
numeric value. A click into this area entails an absolute
change of the input value, which is set proportionally
to the height of the level.

Illustration 5.78:
Parameter Wheel 1

Furthermore, the desired value can be entered
manually by (virtual) keyboard:

Illustration 5.79:
Parameter Wheel 2

Illustration 5.80: Parameter Wheel 3

Clicking the digit opens a virtual number block keyboard. Enter the desired numeric value
just like you would with a calculator and confirm with ENTER. To operate the number block
keyboard, either use the mouse or the keyboard, if connected.

6
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5.9 Crack detection with the Optimizer4D
With the Analyzer4D you are able to monitor a set of frequency bands and to identify
occurring energies. Internal and external signals control the visibility of the energies for the
Analyzer4D to therefore show or hide process noise. The trigger system allows to transfer
recognized conditions which then can be evaluated outside of the crack detection module.
5.9.1 The input dialogue “Crack detection”
Click Automation in the main tool bar. This opens the automation toolbox on the bottom
window border. For crack detection you will need the buttons Crack Detection and Activate
Automation.

Illustration 5.81: Toolbox Automation

Click Crack detection to open an input dialogue in which you configure the crack detection
for the project that is currently active.
Check the box next to Activate Automation to activate crack detection for the next and all
following measurements.

Illustration 5.82: Dialog crack detection – crack definition

5.9.2 Crack detection
Crack detection with the Analyzer4D works by creating crack objects out of so called crack
definitions. Each crack object monitors a certain range of frequency and time. If a
transgression of energy is detected in this area the event is reported to the trigger system.
Numerous parameters allow to prompt complex sets of conditions. For example, triggers or
energy transgressions can activate or deactivate other crack objects.
All events detected are being logged. They are recallable on the statistic data page and can be
identified by their process number and crack object.
The input dialogue provides all functions essential for the crack detection:
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5.9.2.1 Tab Crack Definition
On this page you can choose the kind of energy treatment, set the measuring channel, enter
the framework parameters for the possible crack events and define the energy values of the
three crack versions. With a click you add a newly created crack definition to the list and
change or delete already existing parameters.
5.9.2.2 Tab Detected Cracks
This page is used to show results of the crack detection – both current and prior.
Moreover you can simulate a crack detection run on an existing process.
5.9.2.3 Tab Settings
Set more parameters for the crack detection:
The option Send signal for all crack events arranges for every single crack event that is
detected to be sent as a trigger signal. These signals can be evaluated by the trigger type
Crack event.
5.9.3 Parametrising the crack detection
In this section you define the parameters of a crack event. Start with clicking on the tab
Crack definition.
Please mind that a new crack definition will only be created if you first click on Add Object
To Definition List. If you want to change the parameter of an existing crack object, first
mark it in the crack object list on the bottom edge of the crack detection dialogue, change the
desired parameter and then click Modify Selected Definition.
Important: If you click on an existing crack object all of the corresponding parameters are
entered in the dialogue and alder settings are overwritten.
5.9.3.1 Step 1: Allocate Names and adjust object type
Each crack definition can be labelled. This function solely serves a better overview; you will
be able to find the identification in the list of crack objects after you have applied the object
itself.
Even more important is the object type. The selected type determines the way the device
reacts to the measured energies:
Crack object
The object reports energy transgressions, which it does in two to three increments: micro
crack, crack and break. This is used as standard in the crack detection.
Range object
This object expects energies between a minimum value and a maximum value (the maximum
value can optionally be ignored). If the measured energy exceeds or falls below these
thresholds, an appropriate signal is transmitted to the trigger system.
Expected object
The “Expected Object” expects an event with the set energy within the defined range of time.
It will only send a “NOK”-signal if NO energy event is recorded at the moment of its
deactivation. So this is to be understood as a reversal of a crack object.
Min-Max-object
On the contrary to the previously listed objects, the Min-Max-object does not focus on
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summarised energies but on individual amplitude values. During the active stage of the object
these amplitudes should not exceed the freely adjustable maximum frequency mask or falls
below the minimum frequency mask.
If events are detected via a crack object, they can lead to a “NOK”- or an “OK”-signal,
depending on the type and parametrisation. However, if the crack object is only used to
activate or turn off other objects this is normally not wanted. In order to take the object out of
the evaluation you have to uncheck the box next to Show Object in Crack Results. It can
still be used to start or stop other crack definitions.
5.9.3.2 Step 2: Set data source

Specify the data source and the type of data with which a crack parameter object should
work:
– Channel
– Data mode: Signal- or FFT-Data
– Compression
– Buffer-Type: Raw data or several compressed buffers.
5.9.3.3 Step 3: Limit area

A crack object monitors a previously defined frequency area within a certain time range that
can also be set. It seeks certain energy levels that indicate a crack or an energy event. In the
tab Time spreads you adjust this area.
Noise level
In the measuring all amplitudes that remain below this threshold will be ignored in the
observation of energy. Adjust the noise level either by entering a number or by using the help
layer: Move it to the desired level in the 3D-landscape and then click get from help layer in
the input dialogue of the crack detection. The height of the help layer will now be interpreted
as a number and copied into the input field.
External activation and deactivation
Crack objects can be activated and stopped by external signals (triggers). Checking the first
check box will cause the crack object to react to start triggers. Checking the second box
prepares the object to be stopped by a trigger command.
The related triggers are: Activate definition object and Deactivate definition object. The ID
of the object, an enumerator or an Enable all respectively a Disable all, is transmitted as a
parameter.
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The negative delay is used in order to hold back crack signals for a freely adjustable amount
of time in ms. This makes sense when, for example, loud noises coming from a machine
occur at the end of the measuring, that are not supposed to have influence on the crack
detection. In this case the crack parameter objects are set on negative delay (e.g. 20ms) and
and the stop trigger deactivates them. This procedure provokes a certain effect for the system
itself: the crack detection is being deactivated 20ms before the end of the measurement.
Actually, the crack signal resulting for the machine noises is restrained until measuring stop
and then discarded.
Time spread
The crack parameter object is active within the time range that you can enter here. The object
will not detect cracks before and after. This makes sense if you want to mask loud machine
noises at beginning or the end of the process. If you enter a zero in both the staring and
ending spread fields, the whole process will be monitored.
By clicking get from selection you simplify the setting: the time values of the selection that
is currently active are determined and imported.
Detection runtime
The detection runtime is another method to determine the active time of a crack parameter
object. This option is set in the selective box – if the crack parameter object is now started by
a start trigger during the measuring, it remains active for the time span that you entered into
the input field. The unit is ms.
Frequency range
In the Analyzer4D you can create frequency masks and therefore include or exclude any
frequency bands in/from the crack detection. As for all other settings the frequency mask
respectively applies for one object.
Click switch to Frw mask.
You can now see the process landscape which has been oriented so that you know see the
frequency axis. A mask is laid over it, a blue bar. You can distort this bar by inserting anchor
points and then moving those.
– Add point: Click on the point of the bar where you want to create an anchor point. Anchor
points are displayed as red dots. Right after creating a point you can move it around by
clicking it and holding the mouse button. A point that already exists can be moved by
clicking it and then move the mouse or your finger.
– Delete point: You can delete an anchor point by right-clicking it.
– Engaging area: You will find that anchor points which are moved upwards snap into place
on the line that displays 100%. Just move a point further upward if you want it to move
freely again.
To mask frequency ranges pull the bar to the lowest point possible at these points, to 0%. If
you want the amplitudes to be able to pass through unhindered, set the band to the 100%engaging line. Choose an area in between and the amplitude will be scaled between 0%100%. It is also possible to reinforce the amplitudes of specific frequency ranges. To do so,
set values over 100% for the anchor point.
You can perform a fast default using the input boxes and enter frequency bands from 0 to 511
or select the area and click “get from selection”.

5.9.3.4 Step 4: Choose algorithm
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All crack object types, excluding the Min-Max-object and the statistic-object, have different
algorithms to choose from for energy ascertainment:
De-logarithmise
In most cases a logarithm is applied to the amplitude data in buffers to make even small
signal visible. Crack objects provide the option to work with de-logarithmised amplitude data
despite logarithmised starting buffer.
Window
This function pushes a window over the process landscape, the size of the window is
adjustable; the energy inside the window is the source for the crack detection. The energy
amount consists of the summarised amplitude data enclosed in the window. If there is a
frequency mask applied, it will affect this algorithm.
You can indicate the size of the window in spectra as well as in milliseconds.
p-value
The energy is continuously summarised spectrum by spectrum and at the same time the pvalue is subtracted; in doing so it dampens the energy curve. Here, too, the frequency mask
influences the incoming energies.

5.9.3.5 Step 5: Enter thresholds and object parameters

Depending on the crack object type you can set energy thresholds or different parameters in
this tab. Also, this is where you set the warnings. If a threshold is exceeded the Analyzer4D
does not send a “defective”-signal immediately. For most of the object types you can set how
many transgressions will be accepted before a “NOK”-signal is transmitted to the trigger
system. You enter the number of allowed transgressions in the warning field.
Crack object
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Crack events can be distinguished into micro crack, crack and break. For each one you can
enter an energy threshold or transfer the value from a selection. The three check boxes all
three, two or just one threshold are activated. If you need, for example no distinction into
micro crack, crack or break, check the box in the line “break”. The micro crack- and the crack
line are greyed out and therefore not active anymore.
To determine the energy of a crack event, chose a process that shows typical crack signals.
Mark one of the signals by drawing a selection rectangle around it and click on Get energy
value from selection. The energy value of the selection is determined depending on the size
of the energy observation window of the window energy algorithm. Afterwards it is applied
against the adjacent percentage and then registered. The percentage is used to get a sensible
threshold below the actual energy value; in order to detect the selection as a crack incident
with certainty.
Range object
Similar to the crack object, here energy values can be entered or transferred from selections.
However, “maximum and minimum energy” are the options for the range object, whereby the
maximum energy can be deactivated.
When the object is activated it will look for energy values within the entered minimum or
maximum values. The range object will trigger a “NOK”-signal, if the expected energy value
is not detected.
Expected object
You can enter the “expected energy” into this object type.
Expected object are not being evaluated until they are deactivated: they send an “OK”-signal
to the trigger system if the entered value is exceeded. If the measured energy falls below this
value it sends a “NOK”-signal. The expected object can only be rated as “not appeared”, thus
NOK, when the system is sure that the time span in which the object is expected has passed.
The end of this time span is indicated by the deactivation of the object or by the preset time
having elapsed.
Min-Max-object
Contrary to other object types the Min-Max-object does not require energy values. If you
click switch to Min/Max-mask you can set two amplitude masks on the frequency axis. The
handling is identical with the frequency masks in the tab Crack Detection Area. The axis
entitled CP Max Level shows the upper limit of the expected amplitudes, CP Min Level
shows the lower limit. If you leave the CP Min Level on the zero axis, the minimum level
will be neglected.
If an amplitude exceeds the max level or falls below the min level during the automation,
both for a certain amount of time, a NOK will be triggered. This time span can be entered
under necessary breach duration. If you want to notice every transgression, enter a “1”.
Please mind that thousands of events are quickly recorded with this setting. You should also
apply Min-Max-objects onto smoothed buffers (e.g. a moving average).
Crack events can be used to activate or deactivate other crack parameter objects. This makes
sense if you want to override a strong signal or use it to start the actual crack detection.
You can activate this function by checking the box next to Activate. You enter the IDs of the
crack parameter objects that are to be activated into the field behind it, separated by commas .
Deactivate an ID by placing a “-” behind it.
Note: The warning signals can be connected to different program action in the “trigger
settings”. For example this sets an I/O output on high when a warning is exceeded,
which in turn is noticed by the connected PLC. The trigger type that reacts to the
warnings is called “Crack limit exceeded”.
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(See also: “Details – Trigger settings”)

5.9.3.6 Step 6: Test definition
Choose the tab Energy signature and click on Calculate energy curve of the current
process. In the display the energy curve of the current process will appears, calculated
considering the frequency mask set in the crack parameter object. The thresholds for micro
crack, crack and break are displayed as lines.
This display can be used to examine your settings: Does the energy curve of a recorded crack
remain above the thresholds, as intended?
5.9.3.7 Step 7: Save definitions

If you have entered or calculated all of the energy values you still have to add the parameters
to the definition list. You can do this by clicking on Add object to definition list. Your
settings will now show up in the list. If you want to change them afterwards, choose the
parameter set in the list and change the parameters as desired. Then click Modify selected
definition.
Clicking delete object erases the selected entry from the list.
5.9.3.8 Step 8: Create further definitions
Until now you have always added exactly one parameter set, respectively a crack parameter
object. If you want to measure in several channels or monitor different time- and/or frequency
ranges, you can do so by creating further crack parameter objects.
5.9.3.9 Step 9: Save
Save your settings by clicking on

File → Save Project

in the menu.

5.9.4 Measurement and Analysis

The settings have been completed and saved. If Activate Automation is checked off in the
automation toolbox you can start the measuring, which will be monitored by the crack
detection.
With the ending process the results are automatically saved into the data base; you can
examine them in the input dialogue of the crack detection, under the tab Detected cracks.
5.9.4.1 Selected evaluated processes
In the typical production environment your Optimizer4D will have monitored thousands of
processes after a short period of time. The results of each process and measuring will be
stored.
You can view the results for each one of the processes or even whole production stages in a
list.
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You can also filter the displayed list by OK and NOK results.
To do so, just click the tab Detected Cracks.
Attention! For one the maximum amount of recorded processes is limited by the space
left on the hard drive. On the other hand you are able to adjust the maximum amount of
saved measurement data manually. You can find this setting under
MenuConfigurationSettings in the tab General under max process... .

Using the input fields from process and to process you can set the desired range. Current
Process gets you the number of the currently selected process in the display of the
workspace, Last Process gets you the number of the last recorded process.
Instead of the process numbers you can also enter a date for the first and last process to be
displayed, just click on the calendar symbols. The program will search for the corresponding
process numbers and enter them in the input field.
After choosing a process range, all of the processes with calculated results in crack detection
will be shown in the list Processes with Crack Detection record.
5.9.4.2 Subsequent crack detection
In case there are no crack detection data available for processes within the selected range or
you want to test other definitions, you can have them calculated later.
Please note that crack detection results recorded during the measuring cannot be overwritten.
Data that is recalculated are assigned to one of three simulations. You can set the desired
simulation, respectively the original data via a drop-down box: Show process data results
shows original data and Show recalculated simulation data 1 to 3 shows you recalculated
data on the one hand. On the other hand you can determine which simulation you want to
assign the data to by clicking Recalculate Cracks for Chosen Processes.
This function is suited for optimising the quality of crack detection with different
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parameter sets on a basis of prior measurements.

5.9.4.3 Process list
The process list with Crack Detection records cites all processes wit crack detection data
within the defined range.
An entry is composed of:
• Status light: It indicates if a process, and therefore the component, has been rated OK
= “okay” (green) or NOK = “defective” (red).
• Process number
• Date
• Time
You can filter the displayed processes by their condition; Show filter options: All Processes
lists all processes regardless of their condition; NOK Processes (with warnings) only show
processes with a red status light, OK Processes all with green status lights.
5.9.4.4 Crack detection results in detail
Select a process to get further information about it it. Those will be shown under Selected
Process info.
At the top you will see the serial number (if activated), process number as well as the number
of detected micro cracks, cracks and breaks. The score includes the variations of the activated
warnings and states the quality of the process. Here, a high score stands for a bad process.
In the list below you can see all of the parameter sets that you created. The three numbers
separated by a “/” stand for the amount of detected micro cracks, cracks and breaks. If crack
events have been detected, you can open the crack parameter object and thus get information
about the events.
Note: Click on a crack event in the list and the program will display the related process
in the current workspace as well as set a respective time range for the scene. The green
focus point line shows the exact position of the crack event.

5.9.4.5 Energy curves
Click the tab Energy Charts and check the box beside Enable process energy view to
display the energy curves for each crack parameter object.
If you select Processes with crack results the Analyzer4D will calculate the respective
curves.
- the vertical lines display the set energy thresholds of the crack parameter objects.
- Click on a crack event in the list Selected Process Info. The result will be marked in the
energy curve.
5.9.4.6 Long-term test Functionality
The Analyzer4D enables long-term tests for workpieces and displaying the data accordingly.
A long-term test shows the following characteristics:
– A workpiece is stressed or tested arbitrarily often
– All measuring results have to be associated with this workpiece
– Several workpieces of the same type can be administered per project
The long-term test functionality is not an attribute of the crack parameter objects. It is shown
in the system by a trigger command:
Set polycyclic mode
Set pending polycyclic mode
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The trigger parameter switches the long-term test on and off as well a initiating a change of
components (deactivate, activate).
Has the long-term test been activated with the trigger command you can see this in the
process information. It will say there, for instance, “Sub process 1 (Start: 56)” - which will
read as follows:
– The individual measuring of a long-term test with a workpiece is numbered consecutively
starting from 1 and labelled “Sub process”.
– The process number of the first sub process gets carried along; in the example above this is
the 56.
During an activated long-term test the sub process is incremented with each new
measurement, while the starting process remains identical.
5.9.4.7 Evaluation of crack events in the long-term test
Open the tab Detected Cracks. Then open the filter options with a click on Show Filter
Options. Open up the drop-down menu All Process Types and select Polycyclic Processes to
show the crack detection records in the process list that have been recorded with the
polycyclic function. You can read the starting process (“First”) as well as the sub process
(“p”) of a recording in the process list.
In the column on the right side of the process information an additional field showed up:
Polycyclic-Information. It contains the amount of measurements of the just selected longterm test and the number of the first process, analogous to the tip in the list. Additionally, the
field is coloured:
– Green: None of the sub processes of this workpiece has triggered a warning.
– Red: At least one of the crack parameter object has passed the trigger thresholds.
6

115

5.9 Crack detection with the Optimizer4D

5.10

Subsequent Buffer Calculation
In the main menu click on BufferBuffer creation dialog to open the buffer recalculation
window. Here you can calculate compressed buffers with different data types for one or
several processes.

5.10.1

Process range selection

If you wish to create buffers only for the currently selected process, please click on “Select
current process”. You also have the opportunity to calculate buffers for a range of processes
– fill in Start process and End process as desired.
5.10.2

Source buffer mask

For the calculation of a new buffer you need a source. Choose one by going to the check box
of the group Source buffer mask.
5.10.3

Destination buffer configuration

Here you select the desired result buffers and their parameters.
You can check the check boxes to set if...
– ...existing buffers of the same type but different compression will be overwritten.
– ...existing buffers of the same type and compression will be skipped.
– ...old buffers will be deleted. Here, those buffers with buffer types that have not been
selected in the view right of the field are chosen.
Below, you can set the general compression for the result buffers. A change made here will
overwrite all prior values in the buffer type view.
The button ”Set->Recreate all compressed buffer” creates a setting preselection to
recalculate all preciously created buffers.
In the buffer type view you can choose the desired buffer types like maximum, moving
average (over time or time and frequency), average and standard deviation. Set the
compression under Buffer compression – higher compressions result in a lower temporal
resolution but they also take up less storage.
The extra parameter for the two moving averages state the base: A base of 20 means that parts
of 20 amplitudes have influence on the calculation of a value. A higher base implies a much
smoother amplitude course.
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5.10.4

Starting the calculation

After you have completed all the settings you can start the calculation by clicking the Start
button on the bottom right. You can cancel the action by clicking the according Cancel
button. Hide/Close closes the dialog but does not interrupt a currently running calculation.
6
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5.11

Sensor Calibration
Select the menu Configuration → Sensor calibration to open the settings dialogue of the sensor
calibration.
The functions offered allow you to examine the connected sensors as well as their coupling to
the workpiece or the machine.
The sensor test proceeds in two steps:
1) First, the so-called cable test is conducted. At that the sensor cable and the sensor of
the pre-amplifier are being charged. Afterwards, the duration of the capacity discharging time
of both sensor cable and sensor is measured. If the ascertained value (8000µs – 20000µ,
depending on the length of the cable and sensor type) does not lie within the tolerance range
the cable test fails and the respective report is generated. That way cable breaks or short
circuits can be detected.
2) If the cable test was successful the system initiates the coupling test.
To this the Analyzer4D charges a condenser in the pre-amplifier and discharges it abruptly
over the sensor. The system response resulting from the impulse is measured and rated. Also,
if the tolerance limits are violated the system generates an error message.
The parameters of the selftest can be stored as a reference model and later consulted to match
the system response with the prior values after changing the sensors. This is important to
receive comparable readings despite of the varied setup. There are parameters available for
the matching as well as a graphic representation: While you are screwing on the sensor you
can see the effect on the coupling.
Note: The selftest can be performed automatically before and after each measuring to
assure the proper coupling of the sensor or sensor cable. QASS recommends to start
the sensor test by going to the trigger system and using the trigger command “Perform
selftest”.
This is how you activate the automatic sensor test: Menu Configuration → Settings
Choose the tab Measuring → tab Expert Setting and activate one of the options
just before measuring or Execute sensor test directly after measuring .

Execute sensor test

Illustration 5.83: Dialogue Sensor calibration

5.11.1

Impulse parameter
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Subsequent the parameters that are relevant for the impulse test.
Group Port

The setting are done per port. Each port (and with that each connected pre-amplifier) receives
an individual configuration set. Change the pre-amplifier by clicking the selection box in the
group Port . The executed changes will be retained during this. A green tick indicates the
currently selected port.
A flashing green LED above the selection boxes shows that a pre-amplifier is connected and
operative. A red LED indicates an error in the configuration or a communication error with
the pre-amplifier. If the LED is grey, no pre-amplifier is connected to that port.
All of the connected pre-amplifiers and their sensors have to be parametrised
consecutively for functional configuration.
Save settings for port

Operate this button to save the settings made for the port that is currently selected.
Attention! The settings are not saved automatically when you close the calibration
dialogue.
Pre-amplification factor:

Using the Pre-amplification factor you set the amplification that the pre-amplifier will use on the
impulse test.
The standard value is 800.
Note: With Optimizer4D systems whose linear pre-amplifier scale is activated this value
may have to be increased.
Impulse energy (1/x):

The impulse energy sets the intensity of the pulse. Please note that with impulse energy a low value
indicates a strong charge which therefore leads to a highly energetic impulse, whereas a high value
(maximum 4095) indicates a weak charge.
Pulse number per test impulse:

With this setting you can optionally set an impulse series for the sensor test. The number of impulses
determines how often the charging-/discharging cycle is repeated for the test. The standard value is
1.
For components with poor feedback or strong signal absorption is makes sense to
increase this setting.
Minimum of needed correlation (%):

This setting determines how strong the similarity between the ascertained energy of the impulse
response and the deposited reference energy has to be at a minimum, so that the test rates “OK”.
QASS recommends values from 50% to 80%. Values that are too high do not make sense due to the
measure tolerance.
Attention! A minimum correlation value of “0” deactivates the energy comparison.
Noise threshold:

The noise threshold marks the minimal signal amplitude that has to be exceeded in the impulse
response to be included in the energy calculation. This setting allows you to filter an ambient noise
heightened by the environmental situation (easy to spot in the process landscape) out of the
measuring signal.
Energy threshold at the start of signal evaluation:

This is the minimum energy that has to be exceeded for the Analyzer4D to identify the signal as the
start of an impulse response. If the impulse response during the sensor test is identified too soon
(noticeable by the transparent background of the selection area in the process landscape) this value
should be increased. The standard value is 20000.
Cable test minimum discharging time (µs):

This is the discharging time that cannot be fall below during the cable test.
Cable test maximum discharging time (µs):
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This is the discharging time that cannot be exceeded during the cable test.
Attention! Values that are “0” for the min. or max. discharging time of the cable test
deactivate that very thing

5.11.2

Expert and service technician parameters

Note: These parameter are still visible or available, depending on the user level

Illustration 5.84: Sensor calibration: parameters for Experts and service

Preamp amplification delay

This is a parameter that has direct influence on the timing of the discharging impulse concerning the
actual measuring of the system response.
The process in the pre-amplifier happens as follows:
• Measuring off: First, the measurement chain is interrupted in the direction of the multiplexer
by an analogue switch
• Charging phase: Now, the impulse circuit is charged inside the pre-amplifier
Impulse: When the adjusted maximum charge is reached it is discharged abruptly over the
connected sensor.
• Measuring on: Now the analogue switch is reactivated. Thereby the A-D converter on the
measuring card receives an input signal again.
The parameter Preamp amplification delay influences the time span between the impulse and the
measuring. The resulting value is about the adjusted value x 50µs.
This expert setting allows you to filter out influences of the charging circuit and the discharging
impulse of the system response.
•

Energy detection delay

This parameter determines how big the time span is after the transgression of the Energy threshold
at the start of the signal evaluation (the front edge of the measured response signal) and the actual
energy evaluation. Thus, the amount constantly pushes back the evaluation by the adjusted value.

5.11.3

Group Analysis

Four parameters are shown here:
Signal Energy Correlation:

This value describes the similarity between the energy of the current sensor test impulse and the
energy of the recorded reference value in percent.
The higher a value, the more the coupling of the sensor matches the recorded sequence.
A value of 100% indicates an ideal congruence.
A value of 0% indicates a very low similarity that might be caused by a loose or defective sensor, or
else.
This correlation is compared to the value of the min. needed correlation of the parameter in the
automatic selftest.
Total energy of the reference:

Here the reference energy value is shown if a reference measuring exists.
This value is the comparative value for the total energy of the current impulse test
Total energy of the current impulse test:

Shown here is the energy that is calculated during the current impulse test.
This value is the comparative value for the total energy of the reference
Additionally, the energy average over all the test impulses during the continuous pulse sequence
shows up in brackets.
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Different sensors often have divergent frequency responses which prevents a good
correlation. Look to it, that reference and impulse at least only raise a slightly divergent total
energy. These two values help you with that.
Cable test discharging time:

The measured discharging time that has been determined during the cable test shows up here in µs.
Min. discharging time of cable test and max. discharging time of cable test should be adjusted, so that
the value safely lies within the tolerance range.

5.11.4

Sensor impulse response diagrams

In the lower range the determined parameters are graphically plotted.
Two diagrams are available here.
One displays the energy of the impulse response compared to the time. Here you can assess if
the system response is being captured correctly and how the energy proceeds.
Attention! If the graph is jumping to and fro in the diagram more than 2ms between the
individual test impulses or during non-stop pulse operation, the impulse will not be safely
recognised. In this case, increase the noise threshold and/or the energy threshold at the
start of the signal evaluation.
Note: During the impulse test a transparently displayed selection area in the process
landscape helps detecting if the energy evaluation happens at the right time. You
possibly have to push aside the window of the calibration dialogue for this.

The second diagram compares the maximum amplitude of a frequency band to the frequency.
This graph is suited to judge frequency-dependent damping or resonances. Of course this
graph is also characteristic for every sensor-workpiece combination.
5.11.5

Button bar

Trigger impulses:

This function triggers the sensor test once at the currently selected preamp-port.
At that the cable test and then the impulse test (coupling test) is conducted.
The measuring and energy values are shown in the group Analysis .
Continuous pulses:

This button functions as an on/off switch for the impulse test. Clicking the button activates the
impulse test at the currently selected preamp-port in a quick sequence.
A the same time, you can observe the energy value in the group Analysis and possibly arrange for a
higher correlation of the coupling value by adjusting the tightening torque at the sensor.
Another click will stop the generation of impulses.
Note: The continuous pulse determines the average energy over all the impulse responses during
an activation phase. This value is saved as a reference value when the reference model is being
stored.
Note: In the continuous pulse function no cable test is performed to ensure maximum
speed in the impulse sequence. This is why a sensor cable that is removed for test
purposes will not be recognised.
Save impulse response as reference:

Click this button to deposit the latest results of the sensor test as reference in the current project.
Now the self test and the sensor function of the Analyzer4D application is configured and can be
induced any time by trigger commands or by manually invoking the menu
Measuring → Perform sensor test.

Note: The system can be configured, so that the deposited reference data have global validity for all
projects. (Menu Configuration → Settings tab General selection box
Global sensor calibration settings )
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Close:

Closes the calibration dialogue.
Attention! A continuous pulse test running at that time will not be stopped.

6
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5.12

Details Data export
You reach the CSV data export dialogue over the menu FileExportBuffer as CSV.

In this dialog window you can export a compressed buffer to analyse it externally with a
program of your choice. At the moment the Analyzer4D provides one export format: CSV.
5.12.1

Parametrise export source

The dialogue sets the currently selected buffer as the starting buffer, which will be shown in
Buffer. For example you can read there "Ch1 FFT:Mov.Avg (1/32 base20)". Ch1 stands for
channel 1, FFT for the data mode (in this case the process landscape with time- and
frequency axis, Mov.Avg for the moving average as data type. 1/32 indicates the compression
and base20 the base for the moving average.
In case the displayed buffer does not match the one you desired, close the dialogue,
choose the favoured buffer and click FileExportBuffer as CSV again. The correct
buffer should be displayed now.

Now set the beginning- and the ending time. The values displayed in the input fields match
the limits of the buffer in the default. So, if you want to export the whole buffer, you do not
change anything here.
Next to the time you can also set the area to be exported on the frequency axis. The
Analyzer4D usually uses 512 frequency bands, therefore the selected area should lie between
1 and 512.
5.12.2

Set export format

The individual data of the CSV file have to be separated by a character. You can select this
character in Separator. The Analyzer4D offers you tabulator, semicolon and comma.
Furthermore, you can determine if the first column gets a time stamp.
And additionally you have the option to have data subtracted out of the logarithm by making
a cross in the according box.
5.12.3

Export target

With the button Export to project directory you set the storage path as the project index.
The data are stored in the subfolder "export/".
Export to file system allows you to choose the storage path freely.
5.12.4

Export

With a click on Start Export the export is finally executed.
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5.13

Details Statistics Tool
With the statistics tool you can rate changes in consecutive processes and then easily display
them. Statistic functions available are the average, the standard deviation, the median and the
quartile.

5.13.1

Requirement Selection Sets

First, you have to select areas that you want to be analysed. For this, go to EditSelection
Sets.

On the left side you will find a list of the areas selected before. At the moment it is still
empty. Beside it is a series of six sets in total. You can store several areas in each set to have
fast recourse to it later.
At the far right you see the buttons that save and delete areas; with Clear Set you delete a
whole set.
Below, in the bar, you can close the dialogue by clicking Close or select the statistical tool
dialogue with Statistical Evaluation.
5.13.2

Select areas and save

Choose a buffer you want to perform the statistics analysis on and mark an area in the process
that you want to evaluate statistically. You can select by holding the middle mouse button and
drawing a rectangle.
Click Add Selection. In the area list appears the area marked earlier, with its start- and stop
time in samples as well as its frequency range in frequency bands (from 0 to 511).
All of the areas marked like this can be analysed with the statistics tool.
5.13.3

Overview Analysis Dialogue

To open the dialogue click Statistical evaluation in the area dialogue or
AnalyzeStatistical functionsStatistical evaluation in the main menu. In the upper area
you can choose the settings for the statistical evaluation, the area on the bottom serves the
display of the analysis charts. Here you can switch on the different statistical methods in
addition or deactivate them after the calculation.
Please mind that the statistical evaluation is done on the buffer type currently shown in
the scene.
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5.13.4

Parametrisation

In the first two field you enter the first and the last process to be examined. Below you can set
the Noise threshold. Only amplitudes that lie above it will be included in the calculation. You
can enter the value manually or use the help layer: To this, pull the layer to the favoured
height and click on Copy from help layer. The value will be copied to the field
automatically.
Choose a Selection Set that you created before.
Start the evaluation with a click on Evaluation. The calculation can take a few seconds or
minutes, depending on the number and size of the processes. You can cancel them early by
clicking on Abort.
5.13.5

Chart Analysis

In the chart view you should be able to see the first data now. The statistical parameters of a
process are being plotted in the vertical axis: A vertical line that has a width of one pixel
matches the process precisely. The grey lines serve the orientation and mark every 10. (light
grey) and every 100. (dark grey) process.
You can switch on and off the display of the average, the standard deviation and the median
complete with quartiles. Each method uses individual colours to isolate themselves from
other statistical procedures:
– Red Line: average
– Violet Line: standard deviation
– Blue, green and red Line: quartile (Q75), median and quartile (Q25)
Quartile: The green line states the amplitude value of the median, the red (lower) line
the amplitude value at the transition from the first to the second quartile (Q25), the blue
line states the transition from the third to the fourth quartile (Q75). Thus, between the
red (Q25) and the blue line (Q75) lie 50% of all the amplitude data.

5.13.6

Selections
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Each selection in the chosen set is represented with an own chart. You can change the
selection chart by clicking on the tab Selection and choosing a different area in the list that
will appear. The chart view is updated immediately.
5.13.7

Export

You have the opportunity to export the compiled statistical data for external analysis. Click
the button Export statistic to CSV file. Enter the desired storage path.
6
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6 Tutorials
6.1 Create Project (define workpiece set)
A project contains all the measurement settings for a process operation. It manages all of the
previously recorded processes. And yet a process normally stands for a component or workpiece.
So, a project can also be thought of as a component definition or workpiece definition.
6.1.1.1 Generating a project / Setting names
This is how you create a project:
• Select "MenuFileCreate new project"

Illustration 6.1: new project settings dialogue

•

•
•
•

Enter a distinct and expressive name in the input field right next to "Project name".
Among other things this name is later going to be the base of the file names of the
stored data. It should not contain "space" and special characters.
Optionally, the name can be entered by clicking the "keyboard" icon on the top right.
The memory location for the measuring data is entered automatically. You do not have
to enter anything into the "directory" fields.
You can also enter additional information about the project into the "comment" input
field.
Click "OK"
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Illustration 6.2: Filled in process settings dialogue

6.1.1.2 Set I/O Id
If required set an I/O Id for the project.
You need an I/O Id if you want to use automated changes of the workpiece set (project
changes). This I/O Id can for example be sent through a PLC signal and captured by a trigger.
• Select "MenuFileProjectSet I/O id"
• Enter a number between 0 and 511 into the input field and click "Set"

Illustration 6.3: Set I/O Id dialogue

•

In case the entered Id already exists in a different project, a prompt will appear. In this
case you have the opportunity to acquire the Id for the current project by selecting
"Set overwrite". (The Id in the other project will be deleted)

6.1.1.3 Set measurement settings
Set the measurement settings in the multiplexer dialogue which you can open with
"MenuConfigurationMultiplexer".
Note: If a new project is created, the current multiplexer settings are not deleted. So,
you will get the same measurement setting as in the project you used last.

6.1.1.4 Define/activate trigger
If the Analyzer4D software is intended to be run in the automatic mode (automation) or
external signal are to be used to control the measuring, the "triggers" have to be set up.
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Triggers allow the reaction to certain input signals, like PLC signals or timer events, to e.g.
start or a measuring or change configurations.
You define the trigger list in the I/O module dialogue which you open with
"MenuConfigurationTrigger settings".
Note: When a new project is created, the trigger list of the latest project is not
going to be deleted. So you get the trigger settings of the last project loaded.

6
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7.1.1 Index

Index
Access data...............................................................5
activate / deactivate triggers....................................82
Activate/Deactivate zoom........................................36
Add comment..........................................................34
Add Trigger..............................................................81
Analyse...................................................................28
Analyse → FFT.......................................................46
Analyze...................................................................57
areas.......................................................................70
Auto anti-aliasing.....................................................68
Auto navigation buffer.............................................67
Automatic buffer selection of the time bar...............67
Base unit.................................................................27
bird's eye perspective..............................................52
Buffer.......................................................7, 14, 18, 37
Buffer Box........................................................14, 18f.
Buffer Box context menu.........................................15
Calc Min..................................................................56
Channel scheduling (...............................................74
Clear buffer.............................................................21
Click mode button...................................................52
Colour scale............................................................53
Command................................................................82
compression............................................................67
compression factor..................................................67
Configuration...........................................................41
context menu...........................................................21
Create compressed buffer.......................................37
Create FFT from signal...........................................48
create film................................................................66
cut link.....................................................................26
Data base directory.................................................65
Data type.................................................................14
debug level..............................................................69
Default buffer compression algorithm......................67
Default compression factor......................................67
Delete......................................................................61
Delete last process..................................................34
Delete Triggers........................................................82
Direct input field......................................................27
directory..................................................................66
Disk I/O...................................................................65
Do not dim selected areas.......................................70
Double view.............................................................23
Down-sampling.......................................................67
Drag 'n' Drop...........................................................19
Drag and Drop.........................................................15
DSP.........................................................................74
Dual view –..............................................................25
Enable multi path....................................................66
Enter comment........................................................59
error.........................................................................11
falling edge..............................................................83
FFT oversampling...................................................75

FFT Window function..............................................75
Focus point..............................................................40
Freeze.....................................................................21
frequency axis.........................................................17
frequency display....................................................52
Frequency resolution...............................................64
Graphic area.............................................................9
guide line.................................................................17
help layer.................................................................17
Hide unselected......................................................61
I/O block 4...............................................................68
I/O I.........................................................................83
I/O Ports..................................................................79
Import signal data....................................................38
info view area..........................................................13
Information..............................................................51
Information about version........................................51
Input signals............................................................80
Kernel module.........................................................69
layer box................................................................20f.
layer info box...........................................................20
LEDs.......................................................................80
Lighting....................................................................53
Linking view areas...................................................26
Load last project on application start.......................66
Load next Process...................................................33
Load previous process............................................33
Load process with number......................................33
Load project............................................................29
Log In......................................................................33
Log Window.............................................................11
Main sector scale....................................................54
Main Signal.............................................................19
main tool bar...........................................................10
Main tool bar...........................................................52
Mark........................................................................40
Mark settings...........................................................71
Marking - Flag.........................................................40
Marks......................................................................18
Maximum.................................................................67
Maximum level search - Peak search......................55
Measuring...............................................................45
Menu.......................................................................18
Menu → Process.....................................................33
Minimum level detection..........................................56
Module.....................................................................11
Monitor....................................................................13
Monitor – Main Tool bar.............................................9
Monitor – secondary tool bar.....................................9
Moving Average.......................................................67
mplitude...................................................................18
mplitude axis.........................................................16f.
Multiplexer.........................................................41, 71
Navigation...........................................................9, 18
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Navigation bar...................................................25, 27
Navigation of the graphic window (in the view areas)
................................................................................16
Navigation time bar.................................................18
Navigation time line...................................................9
Navigation timeline a...............................................18
Offset.......................................................................22
ogin...........................................................................5
onitor.......................................................................18
ontext menu............................................................23
OpenGL...................................................................42
ouput signals...........................................................80
Output signals.........................................................80
oversampling...........................................................75
P..............................................................................83
parameter wheel...................................................104
Parameter Wheel..................................................104
Pre-amplifier 1-8 / Pre-amplifier 9-16......................76
Process.........................................................7, 14, 33
Process landscape....................................................8
Process overwrite interval.......................................66
Program surface........................................................8
Project..........................................................7, 66, 111
Project → Project Information.................................30
Project directory......................................................66
Project manager......................................................32
Quick.......................................................................50
Real-time Diff...........................................................56
Ref. layer 1..............................................................19
Ref. layer 2..............................................................19
reference layer........................................................20
Reference layer.......................................................19
reference layer – examples.....................................22
Reference layers.....................................................19
requency axis..........................................................16
Reset reference process duration...........................34
Reset shift...............................................................56
rigger.................................................................79, 83
riggers.....................................................................82
rising edge...............................................................83
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